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1. System Requirements Specification 
 
1.1 GPU Rendering and Hardware Encoding 

GPU Acceleration reduces the stress that video editing software applies on the CPU and improves the 

speed and efficiency of the software. 

 

How to enable GPU Acceleration in Filmora for Mac 
Click Wondershare Filmora 12 > Preference. 

 
Choose Performance Tab. 

 
Under GPU section, check the boxes in front of “Enable hardware acceleration for video rendering 

and playback”. 

If you would also like to enable hardware acceleration for video decoding, you can also check the 

box in front of it.
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1.2 Mac System Requirements 

Check out the basic system requirements for Mac to ensure the best performance of Filmora. 

 
Check the basic Mac system requirements: 

 
Operating System: macOS V14 (Sonoma), macOS V13 (Ventura), macOS V12 (Monterey), macOS v11 

(Big Sur), macOS v10.15 (Catalina). 

 
If you are using macOS X 10.14, click here to get the Filmora Version 12.4 » 

 
If you are using macOS X 10.12 to 10.13, click here to get the Filmora Version 10.5 » 

 
Processor: Intel i5 or better multicore processor, 2 GHz or above 

(Intel 6th Gen or newer CPU recommended for HD and 4K Videos, also compatible with Apple M1 and 

M2 chip). 

 
Memory: 8 GB RAM (16 GB required for HD and 4K videos). 

 
Graphics: Intel HD Graphics 5000 or later; NVIDIA GeForce GTX 700 or later; AMD Radeon R5 or 

later. 2 GB vRAM (4 GB required for HD and 4K videos). 

 
Disk: At least 10 GB free hard-disk space for installation (SSD-Solid State Disk recommended for editing 

HD and 4K videos). 

 
Internet: Internet connection is necessary for software registration and access to online services like 

Filmstock. 

 
Try Filmora for mobile and pad below: 

 
Try FilmoraGo for Smartphone 

 

 
Try Filmora for Tablet 
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1.3 Tech Specification 

Learn about the tech specification of Filmora for Mac. 

 

Supported Input Formats 
 

Type Container formats 

 
 
 
 
 
 
 
 
 
 
 

Video Formats 

MPEG-1/2 Video file: (.mpg, .mpeg, .m1v, .m2v) 

MPEG-4 Video file: (.mp4, .m4v, .3gp, .3g2, .3gp2) 

QuickTime Movie File: (.mov encoded with MPEG 4 or MJPEG codec only) 

Camcorder File: (.dv, .mod, .tod, .mts, .m2ts, .m2t) 

Flash Video: (.flv, .f4v) 

Audio Visual Interleave (.avi) 

Matroska Video File: (.mkv encoded with MPEG 4 or MJPEG codec only) 

HTML5 Video File: (.mp4, .webm,. ogv) 

Non-encrypted DVD Titles: (.vob, .vro) 

Audio Formats .mp3, .m4a, .wav, .wma, .ogg, .flac, .aif, .aiff, .caf, .au 

Photo Formats .jpg, .png, .bmp, .gif, .tif, .tiff 

Supported Output Formats 
 

Type Container formats or Device/SNS profiles 

Format Common 

video/audio 

.mov, .mp4, .m4v, .mkv, .avi, .f4v, .ts, .mpg, .3gp, ProRes, .m4a, .mp3, 

.gif 
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Some of the above codec formats may need to be supported by the system. 

Type Container formats or Device/SNS profiles 

 
4K .mov, .mp4, .m4v, .mkv, 

 
Devices 

iPhone, iPad, Apple TV, Apple TV 4K, iPods, Apple Generic, 

Android Generic, PlayStation, PSP 

Social Network YouTube, Vimeo 
 
  

DVD DVD disc, DVD folder, ISO disc image file 
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1.4 GPU and GPU Driver Requirements 

Learn about the GPU and GPU driver requirements for Wondershare Filmora V12 for mac. 

To get the best video editing experience with Filmora for Mac, it is recommended to make sure your GPU 

meets the below requirements: 

 
Operating System: macOS V13 (Ventura), macOS V12 (Monterey), macOS v11 (Big Sur), macOS v10.15 

(Catalina), macOS v10.14 (Mojave). 

Processor: Intel i5 or better multicore processor, 2 GHz or above 

Memory: 8 GB RAM (16 GB required for HD and 4K videos). 

 
Also, keep your macOS updated to ensure your GPU Driver is up to date. Click System Requirements 

for Filmora Mac to learn more details. 
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2. AI Features 
 
2.1 ChatGPT Plugin - AI Copywriting on Mac 

Any product or service that looks into selling itself in the market looks into creating text that explains its 

operations. This call-to-action text is often referred to as copywriting, which has been present in the 

market for quite a long time. While its utility has increased, the need to optimize it has become the need of 

the hour. AI Copywriting has introduced itself as a go-to solution for effective copywriting in a qualitative 

environment. 

 
Wondershare Filmora 12 offers its dedicated AI Copywriting tool for generating video scripts, titles, and 

captions with the help of ChatGPT. Find out how to use this particular feature on the latest Filmora: 

 

 
 

 

Before Video Creation 

Step 1: Start Wondershare Filmora on Mac and Launch AI Copywriting Tool 

You have to launch Wondershare Filmora (Filmora 12.1.8 or above version) on your Mac and continue into 

the “Create Project” category. After opening the respective section, look for the “AI Copywriting” button on 

the homepage to launch the specific tool. 
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Step 2: Provide Questions for Creating Video Script and More 

Add a question in the available region to get an entire answer against it. After writing a 

question, click "Submit" to proceed. You can ask a maximum of 20 questions from the AI 

Copywriting tool daily. 
 

 
Step 3: Check Requirements for Generating Perfect Video Scripts 

For those who are new to this feature and are unaware of how to generate a complete video script 

through this service, click the "How to ask?" button to lead to another screen. All the requirements 

for creating a perfect video script are displayed on the screen. After going through all the points, you 

can select the "Back" button to lead to the screen, where you can continue asking questions from 

the AI Copywriting tool. 
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After opening Wondershare Filmora on Mac, continue to select the option of “New Project” in the “Create 

Project” section. Follow through the editing interface and apply the required elements to create the 

perfect video for yourselves. 

 

the platform. 

Although you can utilize this feature before creating a video, it can also be used 

 
 

8 of 349



 

 
 

 
After Video Editing 

Step 1: Proceed to Export the Final Video 

After creating and editing an entire video, you can also consider utilizing the AI Copywriting 

feature for creating captions and other titles for the video. As you lead to export the video, click the 

“Export” button on the top-right screen. This will open a new window where you can define all the 

export settings. 

 

function. 
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Step 2: Launch AI Copywriting Feature Before Exporting 

Once in the export window, select the "AI" button adjacent to the "Name" tab on the screen to open 

the AI Copywriting feature. As the tool opens up, use it to create proper names for your edited video 

by asking questions. Click “Submit” after adding a question across the window. 
 

 
Step 3: Use AI Copywriting For Social Media Content 

When you click the "Export" button for the final time, you will be prompted to a screen where the 

video is rendered. Here, you are provided with the option of "AI title and description for social 

media," which can help you create a proper title and description for social media posting. This AI 

Copywriting feature is quite helpful in getting hold of things that are small but take up a lot of time. 

10 of 349



 

 
 
 
 
 

11 of 349



 

 
Index 

Silence Detection 

 
 

2.2 Silence Detection 
 

 

 
Silence Detection 

Silence Detection will scan and remove silent pauses from your videos automatically. Here’s how to use 

Filmora’s Silence Detection feature: 

 
After imported your video to Filmora, right-click on the video and choose “Silence Detection” option. 
 
 
 

 
 
Now the Settings panel will appear, you can adjust the Threshold, Minimum Silence and Increase Buffer. 
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The process will start, you can click “Export to Timeline” once the process ends. Now you will be able to 

preview the video. 
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Denoise Audio 

If you want to denoise the hum and other background audio from your video in Filmora, just follow the 

steps below: 

 
Detach audio from video and double click audio from the timeline, you’ll see a pop-out audio settings 

window. 

 
 

There will be 3 options: Normal Denoise, Remove hub and Remove wind noise. Adjust these options to 

your desired settings and apply it.
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2.3 Auto Audio Ducking 

Audio ducking means lowering the volume of things like background music in order for your dialogue to 

be heard more clearly. Here are the steps about how to apply it. 

 
Select the clip or clips you want to apply audio ducking to (select the clips you want to hear more 

clearly, not the ones you want to lower the volume on). 

 
Right-click and choose Edit Properties or double-click it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Find the Ducking option and select the lower volume of other clips. A slider will appear, which you 

can use to adjust the volume. 
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2.4 Auto Denoise 

Auto Denoise feature can help you remove background noise efficiently. Here are the steps to apply it. 

 
Select the clip that you want want to remove background noise. 

 
Right-click and choose Adjust Audio. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Find the Denoise option and select Remove background noise. You can choose Weak, Mid, or 

Strong to adjust the noise volume. 

1 

2 
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2.5 Scene Detection 

The Scene Detection feature can detect the whole video and split them all based on different scenes to 

filter out the best parts and split out those shaking parts, blur parts, and so on. 

 
After importing the media file, right-click to select Scene Detection as follow. 

 

 
Then in the pop-up window, click Detect. It will detect the whole video automatically. Now the video 

is split into different clips. You then click Add to Timeline. 

1 

2 
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Now you can start to pick up those unwanted parts, right-click to delete or click the delete box 

directly to remove them. 

 
 

 

 

3 
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Apply AI Audio Stretch on Mac 

 
Re-edit AI Audio Stretch 

2.6 AI Audio Stretch for Mac 

This guide shows how to easily stretch the duration of audio with no complexity of cutting, adding fades, 

or rearranging the beats of music. 

 
AI Audio Stretch gives you an answer to set the audio instantly and lengthens it to the time matching the 

video. It remains the beginning and end of the original music and remixes the middle. 

 

 

 
Usage Scenarios 

AI Audio Stretch plays a vital role in many scenarios. 

 
  One situation is when a vlog with multiple scenes and different music clips, you would expect these short 

videos to combine into one video. Audio set at an ideal time is a natural way to link these valuable 

memories. 

 Another circumstance is a vlog with the same music, but the music time doesn’t match the video time. 

You might face it when you process a long video with only one piece of music. AI Audio Stretch is 

needed to avoid repeating the same melody monotonously several times. 

 

Apply AI Audio Stretch on Mac 

Follow the guide below to change the duration of the audio with ease. 

 
Step 1: Activate the stretch function 

 
Launch the Filmora application on your computer. Then, add the video and audio as prompts. Click the stretch 

icon on the toolbar. 
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Step 2: Change the time of the audio clip 

 
Click the audio clip you want to retime. Then, drag the start or the end of the music clip forward or backward 

in the Timeline. When you are done, click to exit Audio Stretch. 

 
 

 

Re-edit This Feature 

Follow the procedure below to reset the duration of the audio. 

 
Step 1: Re-edit the length if you need 

 
To delete the effect, you can select the clip by clicking on the right side of the mouse and then choosing 

Delete Audio Stretch to remove the stretch effect. Alternatively, you can restart the Audio Stretch function 

by clicking the stretch icon to set it again. 
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Note: 

 
  Filmora AI Audio Stretch only supports the time limit of audio clips from 10s up to 10h. 

  If you use the audio stretch, the reverse effect used before for your clip will be automatically removed. 
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Adjust AI Audio Denoise 

 
  

2.7 AI Audio Denoise for Mac 

This guide helps you remove unsatisfying background sounds with just several clicks of the mouse. 

When you find the audio in the video is difficult to distinguish, use AI Audio Denoise, then you don’t need 

to record the video again. 

 
AI Audio Denoise is based on a well-designed algorithm aiming to cancel out unwanted noise and music 

effortlessly. Compared with the traditional approach, AI Audio Denoise is generative, while the traditional 

method is subtractive. 

 

 

 
Apply AI Audio Denoise on Mac 

Follow the steps below to denoise your audio clips. 

 
Step 1: Select the needed to process 

 
Launching the Filmora application, add the video and audio to the processing interface. Click the video or 

audio clip you want to remove noises. Then, the audio settings window will appear on the left side of the 

interface. 
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Step 2: Set detailed adjustments 

 
Scroll the settings window to the bottom, and then you can find the Denoise section. Choose from Normal 

Denoise, Hum Removal, Wind Removal, or Hiss Removal based on your needs. Click the button on the 

right side of each tool first to activate the function. Then, you can make precise adjustments. 

When you finish the modification, click OK to save the effect. 

 
Adjust This Feature 

 
Normal Denoise is a common function in correcting a whole part of the audio or some single clicks 

or pops. It is used to clear up the crackle and static in vinyl recording videos. You need to decide to 

which extent, Low, Mid, or Strong, you want to remove noise. Stronger settings detect more clicks 

and pops but are at the risk of degrading the audio quality. 

 
Humming noise refers to the hum or hiss sound. Hum Removal gets rid of the power line hum caused 

by lighting and electronics, but it can also remove an overly resonant frequency. The range of the 

amount of reduced noise is from -60 to 0, and the default setting is -25. 
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Wind noises are always there in a video filmed outdoors. If you select to launch the Wind Removal 

feature, it will automatically remove all wind noises in the video, saving a lot of your valuable time. 

 
  The problematic hiss is one of the common unwanted noises but can be identified and avoidable by 

activating the Hiss Removal. You can adjust the noise volume from -100 to 0, and the Noise Level 

from 1 to 6. 

 
Re-edit This Feature 

 
Tip: If you want to remove the change, click the refresh icon on the right side of each tool to delete the 

specific change. To reset all changes, you can click Reset at the bottom of the window or the refresh icon 

on the right side of the Denoise bar. 
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2.8 AI Smart Cutout for Mac 

This guide shows you detailed steps for cutting out a subject from images or videos by AI Smart Cutout, only 

with several clicks. 

 
AI Smart Cutout has been trained thousands of times to accurately recognize the edge of the targeted 

image. It allows you to get the output with neat, smooth, and clear edges. Enough brush settings are 

provided in the system if you want to make more precise adjustments. 

 

 

 
Apply AI Smart Cutout to Images on Mac 

You can follow the steps below to process images with Smart Cutout on Mac. 

 
Step 1: After launching the Filmora application, drag the image from your computer or the library to the 

processing area. 

 
Step 2: One-click the image and select AI Tools in the Video tab. Open the Smart Cutout function by 

clicking the button next to it. Then, click the icon in the center of the section below Smart Cutout to start 

the process. 
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Step 3: Draw the subject you need with the brush icon and adjust it with the eraser icon. The palm icon is 

used to move the picture to where you want to adjust it precisely. 

 

 
Filmora also provides a simple and advanced mode to change some features. The Simple Mode of Smart 

Cutout on the right side of the interface includes the settings for Brush Size, Edge Thickness, and Edge 

Feather. 

 
You can change the Brush Size with this setting when drawing the needed subject. The default size is 

30, and you can set it from 1 to 300. 

Edge Thickness refers to the margin that encircles the subject you want to retain. The default is 0, 

but you can set the range from -100 to 100. 

You can use Edge Feather to adjust harsh edges and is a nice way to blend images, which is 

especially needed when dealing with hair. Its default figure is 0, and you can set it up to 20. 
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Tip: In Filmora, you can decide whether to retain the subject chosen or the background by clicking the 

Invert Foreground/Backg icon, as marked in the image below. 

 

 
Step 4: Set the background by clicking the bust icon on the upper side of the interface. You can choose the 

settings from Toggle Alpha Overby, Toggle Transparency Grid, Toggle Transparency Black, or Toggle 

Alpha. 
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Step 5: Save the modification by clicking OK. 

 

Apply AI Smart Cutout to Videos on Mac 

You can follow the procedures below to use this tool on Mac. 

 
Step 1: Launch Filmora and add the video. 

 
Step 2: Find the Smart Cutout function under the Video>AI Tools section and open it. Click the button 

indicating Click to start Smart Cutout in the center of the section. 

 
Step 3: Draw the subject in the video. Set the Edge Thickness and Edge Feature if needed, and click the 

bust icon in the Simple Mode tab to process the task. 

 
Step 4: Change the background of the video by clicking the bust icon in the upper right corner. Find Click 

to start the Smart Cutout icon in the Simple Mode section and click it. Then, Filmora will extract the 

selected subject from the whole video and export the output in a short while. 
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Step 5: Also, Filmora enables you to track the motion with settings in the Advanced Mode section. You 

can choose from Track One Section Reverse, Track Reverse, Track Forward and Reverse, Track 

Forward, and Track One Section Forward, based on your needs to adjust the object to be tracked. 

 

 
Step 6: After previewing, click OK to apply the changes. 
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Add AI Portrait Filters to Videos 

Filmora AI Portrait feature can separate the portrait and background in a video. 

 
With the help of Artificial Intelligence technology, it can automatically detect the portrait in 

videos and remove the background quickly. You don’t need to use the green screen or 

chroma key anymore. Moreover, you can even add borders, glitches, pixelated, and noise 

effects to make your video stand out. 

 

The AI Portrait filters work best for videos with a single portrait facing the camera straight on. 

Multiple subjects, fast movements, and backlights may affect the result of the AI Portrait feature. 

2.9 AI Portrait 

 

 

How to Add AI Portrait Filters to Videos in Filmora for Mac? 
To apply the AI Portrait filters in Filmora, follow the steps below. 

 
Drag & Drop Media Files to Timeline 

 
Add an AI Portrait filter 

 

Get to the Effects section and click on AI Portrait, then you’ll see nine AI Portrait filters there. Click and 

download the filter that you like. Drag this filter to the timeline to apply it. You can also add multiple AI 

Portrait filters to your video by dragging and dropping them to the timeline. 

1 
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If you want to export videos with the applied AI Portrait filters, you need to use Filmora 

paid version with effects and plugins. 

 

 
The following window will pop up if you are using the free trial version of Filmora since these AI Portrait 

filters are included in the membership benefits. You will have two options: click the Buy Now button to 

upgrade to Pro immediately, or click Try It to continue. 

 

 
Adjust the AI Portrait effect 

 
After applying the filter, you can also adjust the settings of the AI Portrait effect to get better results. 

Double-click the clip in the timeline and scroll down to Video Effects, check the settings of the filter. 
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Export the video 

 
Once all the editing is done, click the Export button. 

 
To export videos with the applied AI Portrait filters, you need to pick up a plan of Filmora and pay for it. 

If you don’t want to buy it now, you can also choose to directly remove the AI Portrait filters and export 

the video by clicking Remove and Export, or select Re-edit to return to the timeline and remove them 

manually. 
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Auto Reframe for Different Aspect Ratios 

The Auto Reframe feature can detect a moving object in any video and automatically crop it 

to suit different aspect ratios instantly. What used to take hours or even a day of editing can 

now be done in minutes. If you often need to post your videos to different social media 

platforms like YouTube, Instagram, and Facebook, this feature will improve your video 

creation efficiency. 

2.10 Auto Reframe 

 

This guide will show you how to use this advanced feature to reframe sequences. 

 

How to Use the Auto Reframe in Filmora for Mac? 
There are two methods to apply the Auto Reframe feature in Filmora for Mac: 

 

Method 1: 

Launch Filmora on your Mac device and choose Auto Reframe. 
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Now, drag the clip you want to crop or hit the Import button to select and import it. 

 

 

 

Method 2: 

35 of 349



 

Launch Filmora and select Create Project. Drag the video clip to the Media area, right-click and 

choose Auto Reframe from the pop-up menu. The clip will be automatically added to the Auto Reframe 

tool. 

 

 
After importing the clip to the tool, you can follow the steps below to auto crop it for different aspect 

ratios. 

 
Step 1: Select the aspect ratio you need, then the reframing will start automatically. 

 
There are 5 aspect ratio options: Widescreen (16:9), Instagram (1:1), Portrait (9:16), Standard (4:3), 

and Cinema (21:9). 

1 
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Once the reframing starts, you can see the result in the preview window. At this point, the video 

outside the frame will be hidden. If you want to see the whole video screen, click on the eye icon in 

the upper right corner. 

 

 
Step 2: If you want to adjust the frame, click the Adjust frame toggle button on the right, then drag 

the crop box to adjust it. Fix the frame to fit your needs, and hit OK to apply all changes. 

2 
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Step 3: You can also change the tracking subject and tracking speed by clicking on 

the Advanced tab under Adjust frame. Choose to track the secondary subject or adjust the tracking 

speed. 

 

 
Step 4: When the adjustment and reframing are completed, hit the Export button to save your 

work. 

3 
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If you want to edit the reframed video, keep reading the following steps. 

 
Step 5: When the video is created, hit the Upload to Filmora button. The video will be automatically 

imported to the Media window in Filmora. 

 

 
Step 6: You can drag the clip to the timeline for further editing. Add music, titles, effects, or 

transitions to enhance it. 

5 
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Step 7: When the editing is done, click the Export button to save and share your video. 
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2.11 Auto Beat Sync 

You can click Auto Beat Sync from the interface, or right click the video to find Auto Beat Sync option in 

Filmora. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Now you can adjust the settings of Auto Best Sync. There are 2 options: Basic Settings and Video 

Effects. 
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Once you changed the settings, click “Analyze” to start the process. Click “Export to Timeline” once the 

process ends. 
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If you want to export videos with the applied AR stickers, you need to use Filmora's paid 
version. 

2.12 AR Stickers 
 

In this guide, you'll learn how to add these cute stickers to your videos. 

 
Drag and drop the video clip that you want to edit to the timeline. 

 
Go to the Effects section and click on AR Stickers, then you'll see lots of cute stickers there. 

 
Pick one and double-click it to check its preview window. If you are satisfied with the effect, drag 

and drop it to the video track to apply it. 

 

 

 

You can repeat the steps above to add multiple AR stickers to your video. 

 
Once you're done with the editing, click the Export button to save your work. 

1 
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2.13 AI Stylizer 

AI Stylizer is a brand new feature of the Filmora video editor for Mac. This function can add stylized texture 

effects to the media file, such as brush painting, vintage film, etc. 

 
Here are the steps to show you how to use AI Stylizer. 

 

Select AI Stylizer 
 

Open Filmora and select the AI Stylizer. 
 

 

 
Import the Media File 

 
Drag or import the media file to Filmora. 

1 
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Apply the Stylized Effect 
 

Click to download and apply the stylized effect that you like. 
 

3 
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Preview the Stylized Effect 

 
Preview the stylized effect. 

 

 

Choose SD or HD 
 

You can choose SD or HD. But the HD might cause lower playback performance and cost more 

exporting time. 
 

 

 

 
Once you are satisfied with the stylized effect, click the Export button to save. 
 
 

 

 

4 
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This is the latest user guide for Filmora V12 (for Mac). 

 
Index 

01 Before You Begin 

02 Get Started Editing 

03 Export 

 

3. Get Start 
 
3.1 Get Started with Filmora 

Wondershare Filmora is a trendy video editing software that empowers you to produce creative and 

polished videos in just a few simple steps. 

 
With Filmora, it becomes easy for you to create any new video project. This guide will walk you through 

the process from importing media files, applying transitions or effects, editing audio to exporting the 

edited videos on Mac. 

 

 

 

 

 
Before You Begin 

Prepare Your Footage/Media File 

 
Filmora supports a variety of file formats. You may check if your files are supported by Filmora here 

. Make sure you save your files on your computer or a storage drive. 

Check the System Requirements 

 
Check out the system requirements of Filmora and ensure your Mac meets these requirements for 

the best user experience. 
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Get Started Editing 
 
 

Create a New Project or Open a Recent Project 

To create a new project, choose the aspect ratio of your video and then click New Project. 

To open an existing project, click Open Project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Create a project in Filmo 

Import Media File 

Click on the “+" icon to browse the local file on your Mac and add files. 

Drag and drop the media file to the Media Library area. 

Import media files from an external device. 

Import with Instant Cutter tool. 
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 Arrange Media Files on the Timeline 

  To arrange the sequences of your clips or other media files, you can: 

 Drag video footages, audio files, images to the Timeline panel and place them in the order 

you wish. 

 
 Apply Transitions and Effects 

 Transitions and Effects would help make your video more eye-catching. The Transition 

and Effects panel includes various transitions and effects that you can apply. 
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 Add Titles 

 Choose an existing title template under the Titles section, type in your text and save. 

 Click on the text to customize the text style. You can save it as Custom to use later. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Edit Color 

Filmora has multiple color editing options. You can: 
 

Enhance the color of your video. 
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 Adjust the white balance. 

 Change the tone: Contrast, Saturation, 

Brightness.  Match the color of two different clips. 

To edit the color, double click on the clips and click Color to change the parameters, and then 

click Save. If you are seeking advanced editing, you can click Advanced. 
 

 

 
 Add Masks 

 Filmora 12 supports you in uploading masks or drawing the mask by hand. After 

adjusting the rotation, scale, width, and other details about the mask, you can click the 

“Save as Custom” button to use it the next time. 
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Export & Save 

Click the “Export” button to choose the final format and location where you want to save files. Or, 

you can share your creations on social media platforms directly. 

 

Filmora is equipped with a complete audio editing solution. You can remove background 

noise, change the audio speed or normalize the audio automatically, and more. 
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Index 

Download & Install Filmora 

 
Register Filmora 

 
 

 
Uninstall Wondershare Filmora 

Try It Free 

Try It Free 

3.2 Download/Register/Uninstall 

Find out how to download Filmora on your Mac, register your Filmora, and uninstall it here. 
 

 

 
Download & Install Filmora 
If you don't have Filmora yet, click the button below to download it. Choose Windows or Mac depending 

on your OS, and then follow the instructions to finish the installation process. 

 

For Win 7 or later (64-bit) 

 

For macOS 10.14 or later 

 

Install Filmora 

To install Filmora, find the dmg file you just downloaded and open it. Follow the onscreen instruction to 

install Filmora. 

 
You will find the download dmg files in the Finder. 

 

Register Filmora 
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You can use Filmora without logging in, but any videos you export will have a watermark on 

them  

Log in to your Wondershare ID 

We recommend you to register your Filmora using Wondershare ID. 

 
If you don't have a Wondershare ID yet, read this guide to learn how to create a Wondershare ID. 

To log into your Wondershare ID: 

Click on New Project on the startup panel. 
 

On the editing mode windows. Click the “Login” in the upper right corner. 
 

A login panel will appear. Enter your Wondershare ID and password to log in. 
 
You will find your Wondershare account and password in the confirmation email you receive after the 

purchase. You can also sign up and log in with Facebook, Google+, or Twitter. 

 

 
 

 

 
Updating Wondershare Filmora 
Go to Wondershare Filmora 12 > Check for Updates, and a window will pop up telling you which version 

1 
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If you purchased the perpetual license and upgraded Filmora to a version beyond the one you 

purchased, your license is no longer valid for the new version. 

you are currently using and whether it is the latest version. 

 

 

You always download the latest version of Filmora for Mac on the product page. Installing it will replace 

the previous version automatically. 

 

Uninstall Wondershare Filmora 
Go Finder > Applications > Wondershare Filmora 12 and right-click it to choose to Move to Trash. 
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The main difference between the annual plan and the perpetual plan is: 

The annual plan provides over 10 updates annually, while the perpetual license only provides 1 

update. 

 

For the monthly and annual plans, the subscription will automatically. You can cancel anytime. 

3.3 Member Plans 

Find out more about different member plans and get the most suitable one. 

 

Member Plans for Filmora 
Filmora has two types of member plans: 

 
 Annual Plan 

 Perpetual Plan 

 
Subscribing to one of the above-listed plans allows you to access all the editing features(Except AI 

Portrait) of Filmora and export the videos without a watermark. 

 

Member Plans for Effects & Plugins 
Filmora’s effects and plugins have one type of member plan: 

 
Monthly Plan 

 
By subscribing to the Filmora Effects & Plugins, you can enjoy the NewBluce FX, Boris FX, and AI Portrait 

features. 
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Index 

How to check the list of keyboard shortcuts? 

 
 

 
Full Keyboard Shortcuts List 

3.4 Keyboard Shortcut Lists 

Keyboard shortcuts allow you to edit videos more quickly. Get familiar with the keyboard shortcut lists. 
 

 
How to check the list of keyboard shortcuts? 

Go to Wondershare Filmora 12 > Keyboard Shortcuts to see a list of all the shortcuts. You can 

search through this list quickly using the search bar at the top of the window. 

 

 

 
How to change keyboard shortcuts? 

Click on any shortcut to change it. You won’t be able to change it to anything already in use. Click OK 

when you’re done to save your changes. You can restore the default shortcuts at any time by clicking 

Restore Defaults. 
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Filmora supports shortcuts on Shuttle Xpress and Nintendo Joy Con. 

 

                                          Full Keyboard Shortcuts List 
 

Module Command Mac Shortcuts 

Wondershare 

Filmora 

Preferences Command+, 

Keyboard Shortcuts Ctrl+Command+K 

Hide Wondershare Filmora Command+H 

Hide Others Option+Command+H 

Enter Full Screen Ctrl+Command+F 

Minimize Command+M 

Quit Wondershare Filmora Command+Q 
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File New Project Command+N 

Open Project Command+O 

Close Project Command+W 

Save Project Command+S 

Save Project As Shift+Command+S 

Archive Project Shift+Command+A 

Import Media Files Command+I 

Record Voiceover Command+R 

Add a New Folder Shift+Command+N 

Edit Undo Command+Z 

Redo Shift+Command+Z 

Cut Command+X 

Copy Command+C 

Paste Command+V 

Duplicate Command+D 

Delete Selected Backspace 

Ripple Delete Shift+Delete 

Close Gap Option+D 
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 Select All Command+A 

Copy Effects Option+Command+C 

Paste Effects Option+Command+V 

Export Selected Range X 

Cancel the Selected Range Ctrl+X 

Nudge Left Option+Left 

Nudge Rightt Optiont+Right 

Nudge Upt Option+Up 

Nudge Downt Option+Down 

Tools Edit Properties Option+E 

Split Command+B 

Trim Start to Playhead Option+[ 

Trim End to Playhead Option+] 

Crop to Fit Command+F 

Crop and Zoom Option+C 

Rotate 90 CW Command+Option+Right Arrow 

Rotate 90 CCW Command+Option+Left Arrow 

Keep Group Command+G 
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Ungroup Option+Command+G 

Show Speed Control Option+R 

Speed and Duration Ctrl+R 

Add Freeze Frame Option+F 

Detach Audio Ctrl+Option+D 

Mute Shift+Command+M 

Stabilization Option+S 

Color Correction Shift+Command+C 

Green Screen/Chroma Key Shift+Command+G 

Red Mark Command+1 

Orange Mark Command+2 

Yellow Mark Command+3 

Green Mark Command+4 

Cyan Blue Mark Command+5 

Blue Mark Command+6 

Purple Mark Command+7 

Gray Mark Command+8 

Select all clips with the same color mark Command+` 
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 Render Preview Return/Enter 

Add Key Frame Option+Left Click 

Previous Key Frame [ 

Next Key Frame ] 

Motion Track Option+X 

Color Match Option+M 

Insert Shift+Command+I 

Overwrite Shift+Command+O 

Replace Option+Mouse Drag 

Reveal in Finder Shift+Command+R 

Apply Option+A 

Quick Split Mode C 

Select Mode V 

View Play/Pause Space 

Stop Ctrl+/ 

Play Full screen Option+Enter 

Snapshot Ctrl+Option+S 

Previous Frame/ Move Left Left 
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Next Frame/ Move Right Right 

Previous Edit Point/ Move Up Up 

Next Edit Point/ Move Down Down 

Previous Second Shift+Left 

Next Second Shift+Right 

Previous Marker Shift+Up 

Next Marker Shift+Down 

Project Beginning Home 

Project End End 

Selected Clip Start Shift+I 

Selected Clip End Shift+O 

Zoom in Timeline Command+= 

Zoom out Timeline Command+- 

Zoom to Fit Timeline Shift+Z 

Select Previous Command+Left 

Select Next Command+Right 

View Left Option+Scroll Up 

View Right Option+Scroll Down 
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 View Up Scroll Up 

View Down Scroll Down 

Zoom In Timeline Command+= 

Zoom Out Timeline Command+- 

Zoom To Fit Timeline Shift+Z 

Zoom In Command+Scroll Up 

Zoom Out Command+Scroll Down 

Enter Full Screen Ctrl+Command+F 

Maker Mark In I 

Mark Out O 

Clear In and Out Shift+Command+X 

Remove In point Option+I 

Remove Out point Option+O 

Add Marker M 

Edit Marker Shift+M 

Miscellaneous Export Command+E 
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Filmora for Mac’s Editing Interface 

 
Property Panel 

 
Player Panel 

 
Media Panel 

 
Timeline Panel 

 
 

 
Resizing Panel Groups 

3.5 Mac Panel Layout 

Wondershare Filmora is an all-in-one video editing software where you can create unique and polished 

videos in a few minutes. In this article, we’ll show you how to know more about the different panel 

layouts of Filmora for Mac. 

 

 

 
Filmora for Mac’s Editing Interface 

Media Panel 

 
Access your media files as well as other resources from audio, transitions, effects, stickers, templates, and 

more. 

 
Player Panel 

 
Preview your videos and take still images using Snapshot. 

Timeline Panel 

Arrange, split, and edit your clips sequence and other media files. 
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What’s New – Property Panel 

 
Filmora for Mac is now equipped with a new addition to its layout called the Property Panel. 

 

 

 

Property Panel 

The new Property Panel for Mac makes all info readily available so you can make adjustments when 

editing on the spot. 

 
All the relevant information on your projects, such as the video, audio, color, and speed properties of 

your clip in the Timeline Panel or Preview Window, is placed on the new Property Panel so you can tweak 

your clips on the fly. 

 

Player Panel/Preview Window 

The Player Panel (Preview Window) allows you to preview your clips during the editing process. This is 

where you can (referring to the bottom-right area of the next image): 
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1. Set playback quality 

2. Tweak display settings 

3. Capture a snapshot of the video 

4. Mark in 

5. Mark out 
 
If you want to use the Player Panel as an independent panel or replace it with the default position, you 

can click the Cross Delete tab or simply drag the panel. 

 

 
Note: 

 
You can take a full-resolution image of the still frame in your player panel with the Snapshot button. 

Snapshot automatically saves the picture to your Media Library as an image for later viewing. 

 
Note: 
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The position of the playhead is located in the lower-right corner and is fitted with a handy time code for 

tracking purposes. You can jump to a specific point on any part of the video if you want to enter a new 

time code. 

 

Media Panel 

The Media Panel displays all your imported source files when creating a project. With the addition of 

Stickers and Templates, Filmora 12 is now equipped with more resources than ever before to create 

trendy videos on your Mac, such as: 

 
  Media: To import your media files. 

 Stock Media: Provide royalty-free stock media in 

GIPHY/Pixabay/Unsplash  Audio: Search the audio files of Filmora. 

  Titles: Select available preset titles and apply them to your video. 

  Transitions: Give multiple transitions to make your video more eye-catching. 

 Effects: Select eye-popping effects for your project. 

  Stickers: Add different stickers to your videos. 

 Templates: To split screen videos with preset templates. 

 

 

Timeline Panel 

The Timeline Panel is where you assemble your clips and effects to your projects. This is where you can 

perform various actions to your media files, such as: 

 
Remove elements like video clips, audio, transitions, etc. 

Split your video clips or audio files into several parts. 

69 of 349



 

 Adjust parameters in media files. 

 Render your video for a preview. 

 Add marker during the post-production 

phase.  Record voiceover. 

 Mix audios. 

 
Notes: 

 
Refer to the screenshot above for performing various functions such as: 

 
1. Basic & Advanced Editing 

2. Video Track 

3. Audio Track 

 

Layout Modes 

With Filmora 12 for Mac, there are six layout models to choose from when editing your projects: Default, 

Organize, Edit, Short Video, Classic, and Dual. 

 
If you’re used to Filmora 11, you can choose the Classic mode to revert back to the original layout. 

Meanwhile, the Dual layout works best for people with multiple monitors. 

 

70 of 349



 

Resizing Panel Groups 

If you want to resize any of the panels meanwhile, simply drag the resizing icon that appears at the 

borders between each panel to adjust to your preferred fit. 

 
Method 1: Place the pointer to the sides, then the pointer becomes a left and right arrow. And you can 

resize panels horizontally, 

 
Method 2: If you want to resize the panels vertically, put the pointer underneath the panels until the 

pointer becomes an up-and-down arrow. 
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3.6 Touch Bar 

Learn what you can do with Filmora for Mac using Touch Bar. 

 
Your Mac's touch bar changes depending on what you're doing and provides controls to make your work 

more efficient. Filmora works with your touch bar to provide a more intuitive editing experience. 

 

Touch Bar on Filmora 
1. Improves your interactions with the software by providing more intuitive control options. 

2. Improves editing efficiency by allowing you to make more changes from your keyboard. 
 

What you can do with Touch Bar 
1. Play and insert clips 

 

 
2. Create a New Project or open a project 

 

 
3. Import videos 

 

 
4. Play / Pause your video preview 

 

 
5. Export video to “Format”/“Device”/“YouTube”/“Vimeo”/“DVD” 

 

 
6. Cut clips and control the Timeline. 
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3.7 Custom Toolbar for Mac 

Unlike all professional-level video editing software, Filmora offers a user-friendly editing interface 

displaying its sophisticated and accessible custom toolbar. It provides quick access to features such as 

"Effects," "Stickers," "Transitions," "Titles," and more. In this guide, we will show you how to access 

Filmora's custom toolbar: 

How to Access Filmora’s Custom Toolbar? 

 

 

First, download the newest version of Filmora on your device, start it, and create a new project by clicking 

the "New Project" button. This action will take you to Filmora’s main editing interface for editing. 
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Overview 

 
Latest Version 

 
 

 
Online Resources 

 
Contact Us 

3.8 Release Notes 

Find more helpful resources about recent Filmora updates. 
 

 
 

 

 
Overview 

Filmora is an intuitive video editor for every skill level, available on Mac, and Windows. It provides one 

platform to push your storytelling boundaries and features a host of tools that help you quickly 

create videos efficiently so that you can easily tell your stories. You can access tutorials, tools, and a 

platform to make even better videos to share with our built-in community. 

 
Latest Version 

The latest/most current version of Filmora is the Octuber release. For more information, see below: 

● Latest Versions and Features: V13 

 
● What's New Overview 

 
System Requirements 

● For the latest system requirements, see Tech Specs. 

74 of 349

https://filmora.wondershare.com/guide-mac/new-features-v11.html
https://filmora.wondershare.com/whats-new-in-filmora-video-editor-mac.html
https://filmora.wondershare.com/tech-spec.html


 

 

 

 
 

 
Online Resources 

● Watch the video tutorial for how to use Filmora: Video Tutorial 

 
● Enhance your mastery of advanced video editing skills: Master Class 

 
● Find out how to create a special effect: DIY Special Effects 

 
● All the information you need to help you use Filmora: FAQs 

 
Contact Us 

● For assistance with product usage, sales, registration, and troubleshooting, see Contact Us. 
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Create Projects 

 
Cloud Project 

 
Creator Hub 

4. Creating Projects 
 
4.1 Startup Window for Mac 

Get to know the new startup window. The new startup window is more informative and intuitive as it is 

redesigned to be more user-friendly. It allows you to have a better understanding of the software’s 

features and what they can do for you to create amazing videos. 

 

 

 

 
You select the function you need by clicking the corresponding tab based on your operational purpose. 
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If you don't see this startup window, please upgrade to the latest version, and then go to File > 

Preferences > General tab to enable this startup window. It will show when Filmora launches 

next time. 

 

 
Create Projects > 

 
Cloud Project > 

 
Creator Hub 

 

 
Create Projects 

The Create Project tab contains a variety of features, along with your recent local projects changeable to 

list view or thumbnail view. The new Start-Up Window is designed to help you get started with your 

project as quickly as possible. It contains all the tools you need for creating a video. 

 
Use the drop-down menu to choose an aspect ratio. 

 
You can choose from a wide variety of aspect ratios by clicking on the appropriate option in this drop- 

down menu. 
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To begin editing, click on Create Project and it will take you to the new user interface. 

 

 
The startup window has added shortcuts to screen tools, which you can select to use as desired. 
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Tools 

 
a. You can start by choosing a template by using "Instant Mode" if you want your videos to look 

more engaging and creative. 

 
b. Easily record your screen with "Screen Record" conveniently so you won’t have to record with 

other third-party apps. 

 
c. Reframe a video quickly with Auto Reframe powered by AI technology that automatically detects the 

focal point of your video and crops it, always keeping it in the frame like magic! 

 
d. Smoothly cut out unwanted parts to trim your awesome videos with the built-in "Instant Cutter". 

 
e. Automatically detect and remove silence with "Silence Detection", so you won't have to remove the 

silence from your video manually. 

 
f. Effortlessly use "Auto Beat Sync" to synchronize your videos to the rhythm of the music of 

your choice. 

 

Cloud Project 

Cloud Project is a great way to safely store your project documents, project templates, and finished videos. 

Get your FREE 1GB cloud storage in Filmora 12! 
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  Download and open Filmora. 

  Click “Cloud Project>Project Files” and then log into your account to activate the cloud. 

 Click “Authorize” to allow Wondershare Drive to quickly back up files 

Now you can enjoy Cloud Project and have your files securely backed up to Wondershare Drive. You can 

also use Filmora’s cloud storage for other purposes such as sharing your projects with others, so they 

can view files with their device. 

 

Creator Hub 

Scale up your inner creative video editing skills with the help of Creator Hub. Creator Hub is a place 

where you can find tutorials and secret skills to inspire your video editing. We've embedded YouTube's 

API so that you can search, save, and comment on creative training videos directly within Creators 

Academy. Creator Hub is perfect for beginners and professionals alike. With a simple layout that makes it 

easy to learn how to edit videos, this software will help you create high-quality footage quickly and 

easily. Videos directly within Creators Academy.  
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Create a new project with Filmora 

 

Filmora project files don't store video, audio, or image files. Instead, they store only 

references to these media files based on the file names and locations. So if you move, 

rename, or delete a source file, Filmora won't be able to find it automatically the next 

time you open a project that uses that piece of media. 

For convenience, Filmora offers you the option of archiving your source files with the 
project. 

4.2 Create New Project 

A project file will store information about your videos. Learn how to create a new project with Filmora for 

Mac. 

 
For every project you create, Wondershare Filmora for Mac makes a project file (.wfp). This file contains the 

settings you select for each sequence in the project and editing decisions, effects, and music used in the 

project. 

 

 
 

 
Method 2 

Launch Filmora for Mac, click File > New > Choose Aspect Ratio 
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In addition to the above methods, you can also start new projects using Touch Bar 
controls. 

 

 
 
 
 

 
 

82 of 349



Printed with Pdfcrowd.com  

 
Index 

Open an Existing Project in Startup Window 
 

Open an Existing Project in Editing Panel 
 

Open the uploaded project in Cloud 

4.3 Open Project 

Learn how to open Filmora projects for Mac. 
 

 
 

 

 
Open an Existing Project in Startup Window 

Your most recent projects will be displayed in the Local Projects when you first launch Filmora. Select the 

target project to reload the .wfp project file. If you need help finding your projects here, type their name 

in the Search box. 
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Open an Existing Project in Editing Panel 

You can also open an existing project while editing in Filmora's interface. Click File > Open Project 

(Command+O) > Open Recent to locate the. wfp file. 
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Open a project in Cloud Project 

Click the Cloud Project in Startup Window, and you can find your uploaded projects here. 
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Note: 

 

4.4 Move Projects 

Sometimes you may need to edit your project on another computer. To move your project, you need to: 

 
Open the project, clickFile>Archive Projector use the hotkeyShift+Command+A, 

 
The project file and the source files will be archived together in the archived .wfp file. 

 
You can now copy or transfer the archived project in .wfp format to another computer and continue 

your editing. Or you can upload the archived project to Inclowdz cloud storage and download it on a 

new computer. 
 

 
 

 

1 

2 

3 
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4.5 Relocate Projects 

Once you change the location of the source files, rename them, delete them, or disconnect the external 

drive where they are saved, Filmora will not be able to find them. Instead, you will be shown windows 

with the locations the files are missing from. 

 

Relocate missing media files: 
 

Click Relocate to relocate the missing files; 

Press OK to reopen the original project; 

If the files have been permanently deleted, you can choose other files as replacements.

1 

2 

3 
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5. Importing & Recording  
 
5.1 Import Media from Third-Party Drives on Mac 

The new version 11.6 Filmora allows users to import video files from third-party drives, including Goole 

Drive, One Drive and Dropbox. Follow the steps below to import media from external drives. 

 
Run Filmora and click “New Projects” from the main interface. Go to the upper left corner, click “Import” icon 

and you’ll see a list of options. 

 

Choose “Import from other Apps” and then you’ll see 3 different drives. Take Google Drive for example, 

click it and you’ll see a “Authorization Refreshing” window, the browser will also open at the same time. 
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Enter your google account and password to access Google Drive. Once you logged in, you’ll see a notice 

page like below. 
 

Go back to Filmora and a new window should appear by now. You can select the video files form your 

Google Drive and download it to start editing. 
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How to Import Media Files 

There are 4 ways to import media files to Filmora. 

Way 1. Click the “click here to import media” in the center of the Media Library to add files directly. 

 

A Media Library is provided for you to organize your media clips to easily and quickly catch 

assets for your projects. 

5.2 Importing 

Wondershare Filmora for Mac lets you import video shot by any digital camera, camcorders, mobile 

devices, etc., in all significant standard and HD video formats. You can also record your video from your 

webcam. 
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         Way 2. Drag and drop to the Media Library directly. 

         Way 3. Go File > Import Media, and choose one of the below sources: 

Import Media Files: Import a single media file. 

Import Media Folder: Import a media folder containing more than one media file. 

Import from External Device: Import media files from an external device like a USB drive, 

hard drive, and more. 

Import with Auto Beat Sync: Import media files with Auto Highlight, Auto Beat Sync, 

and Video Effect features. 

Import with Instant Cutter Tool: Import trimmed/cut video from Instant Cutter Tools. 

Import from other Apps: Import media files from Google Drive, One Drive, and Dropbox. 
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           Way 4. Click the Import on the top bar to import the media file. 
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Index 

01  

02 Project Media 

03 Global Media 

04  

05 Adjustment Layers 

06 Relink Medias 

07  

Stock Media 

Project media includes audio, video clips, and images you need for videos. 

 

 

 

 

 

6. Media for Use 
 
6.1 Media for Use 

Start with Filmora media to create an interesting video. Additionally, you can store your video clips, images, 

audio and video templates in the cloud and share them with other creators. 
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Adjustment Layer 

 

 

 
 

 

You can search for Videos or Photos you like from Filmstock 

Media Integration 

 
 

 

 

 
Project Media 

Import your media files here. 

● Right-click on Project Media, and you can add a new folder. 

● Right-click on Folder; you can rename and add a new folder. 

 
Global Media 

Import media files here to use them in multiple projects. 

● Right-click on Global Media, you can add a new folder. 

● Right-click on Folder; you can rename and add a new folder. 

 
Cloud Media 

● My Cloud Media: You can drop or upload your video clips, images, or audio here to save them 

to your Cloud for backup. 

● Downloads: The media downloaded from your Cloud will be displayed here. 
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Relink Media 

● Right-click the media file that you import in Project Media, choose Relink Media, you can 

replace a new media. 

● If the selected file and the clip you used in the project have different durations, they cannot be 

relinked. Please reselect a file with the same duration to avoid issues. 

 
Photo Library 

After you grant access to the Photo Library of your Mac, you can access the photo on your Mac under this 

tab. 
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6.2 Type of Audio 
Right next to the media lies the “Audio” tab. This is the place where you can find numerous audio clips 

for your videos. 

 

 
You just need to click on the “Audio” tab from the above menu, choose an audio category, pick and drag 

the most suitable audio file to the timeline, and synchronize it with the video file. 

 
FIlmora has a massive audio library, which includes the following categories: 

• Young & Bright  

• Tender and 

Sentimental 

• Rock 

•  Folk  

• Electronic 

Sound 

Effects  

• Travel & 

Vlog 

• Beat Music 

 
You can also import music from your computer by clicking on the “Music” category from the above list 

menu. 

96 of 349



 

 

6.3 Add and Modify Audio 
There are two ways you can use to add audio to your video: one is to import a music file from your local 
computer, while the other is to use the music track from Filmora Video Editor. 

Import Music from Local Computer 

Simply click the "Import" button to browse for audio files on your computer. When you find the target 
music or audio file you need, you can select it and import it to the Media Library. After that, you can 
drag and drop the audio into the “Audio track” in the Timeline for further editing. 

Use Built-in Audio from Filmora Video Editor 

Click on the "Audio" tab on the top of the menu, select any kind of audio and drag it to the soundtrack in 
the timeline. 
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Need to modify the audio effect? 

Double-click on the soundtrack in the timeline to open the sound editing window. You can adjust the 

sound speed, fade in and fade out volume, and more. As well as you can also remove background noise. 
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7. Editing  
 
7.1 Crop and Zoom Videos 

Follow the steps below to crop out and zoom into sections of your video clips on Mac with Filmora: 

Select the video from the timeline, and click on the “Crop” icon. 

 

 
A new window will show out to let you adjust the ratio (preset dimensions: 16:9, 4:3, 1:1 or 9:16) and 

customize the region. Click “OK” once set. 
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To pan and zoom videos, switch to the “Pan and Zoom” function, and you’ll see 4 options in the right 

corner. 
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Zoom in: Using this option, you can zoom in from the larger frame to the smaller blue frame. This feature 

can be used to zoom in on a character’s face in the video. 
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Zoom out: You can also zoom out from the smaller red frame to the larger green frame to show a larger 

screen. 
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Pan right: Move horizontally from the right red frame to the left green frame. To move from the right 

frame to the left to showcase other characters and focus on a particular subject. 
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Pan left: You can move horizontally from the left red frame to the green frame on the right side. This can be 

done to follow a subject or move among characters. 
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Swap the start and end areas: You can instantly swap the start and end areas by clicking the swap 

button. 

 
 

 
 

 

105 of 349



 

7.2 Split & Cut Videos 
Split a video or cut the unnecessary parts are frequently used editing features. Here’s the steps of how 

to split or trim video in Filmora. 

Split Video 

There are two methods you can use to split video. After you imported the video into Filmora, drag the 

video to the timeline. 

 
Move red scissor icon on the timeline to the position where you want to split; and then right click on it. 

Now you’ll see the “Split” option, click it. 

 

 

 
Another way to split video is, select the video from timeline, move the red line to the target dot, click the red 

scissor or the scissor on the top of the timeline. 
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If you want to split video into several parts instantly, the “Quick Split Mode” will help you out. Click the 

icon from the top of the timeline, and then click on the position of the video you want to split. 
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Cut video 

Different from split video, “cut video” means cut and remove part of the video. Thus, it usually requires to 

split the video and then cut it. 

 
First, drag the target video to the timeline, and then split it into 2 or more parts. 
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Choose the part(s) you don’t need and right click on it, select “Cut” to remove it. 
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7.3 Motion Tracking 

Motion Tracking gives you the ability to track moving objects in a video clip and then have other objects 

(text, images, video clips, or elements) follow the same movement. 

 

 

How to Use Motion Tracking in Filmora for Mac 

• Double click on the video you would like to track motion. 

• Under Video tab, choose AI Tools. 

• Turn the toggle on before Motion Tracking. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Place the tracker box over the target area in Preview Player. You can change the size and 

position of the box in the preview window. Then, click to start Motion Track. 
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• Drag and drop texts, images, stickers, or video clips to the track above the video, adjusting their 

position, size, and orientation as needed. 
 

 
• Choose the objects (text, images, videos clips, or elements) you would like to follow the same 

movement of the tracked object. 
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• Adjust the size and position of the text, image, element, or clip that will follow the tracked 

path. 
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7.4 Green Screen (Chroma Key) 

You can use the Green Screen (Chroma Key) tool to make a color range in a video clip or image in a 

higher track on your timeline transparent, so the video clip or image underneath it can be seen in place 

of that color range. You can use this feature to change the background of a clip and make it look like 

you're a superhero flying through the sky or an explorer on top of a mountain. 

 
Green Screen works best if you have a solid-colored background to make it transparent, preferably a 

color that the subjects in the video are not also wearing. The most popular choice is bright green. Here's 

how to use the Chroma Key/Green Screen tool in Filmora for Mac. 

Remove Selected Colors with Chroma Key 

Enable Chroma Key 

 
Double click the clip in the timeline, and choose Chroma Key from AI Tools under the Video tab. 
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In the Preview window, use the eyedropper tool to select a color in the image or video clip that you want 

to make transparent. 
 

 
Adjust Settings 

 
In the video, you can change the borders, transparency, shadows, and much more by adjusting the 

following settings 

 
Offset: adjusts the visibility of the backdrop 

Tolerance: controls the width of the range of hues of the key color 
Edge Feathering: softens the edges 
Edge Thickness: adjusts the edges of the subject 

Alpha Channel: turns anything keyed out appearing black and anything not keyed out appearing white. 

 

Creative Ideas to Use Chroma Key 

The Chroma key makes a color range in the clip's top layer transparent, allowing the background video 

clip or image to show through. 

 
Import Green Screen templates from Media Library 

 
In the Media Library, add your background video and green screen clip. You can also get inspired by 

Filmstock. 
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Remove Green Screen with Chroma Key 

 
Drag your media files to the timeline and put your green screen file above. Double click the green screen 

file and enable the Chroma Key option. The background color will be removed automatically. 
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7.5 Mask 

If you want to create some effects to present the video in a creative way, add mask is a way to go. Here 

we are going to show how to add different types of masks to a video in Filmora on macOS. 

 
Masks are mostly used to prevent the viewers from any distraction and draw their attention to a 

particular action or person. 

 
 

 

Go to the Masks tab 

Double click the video clip in the timeline to enter the Video panel. In the Mask tab, you can find some 

mask shapes, such as rectangle, circle, double line, single line, love and star. You can also draw a mask as 

you wish. 

 
Apply a Mask 

You can apply an existing video mask or load your own video mask by clicking Import. When you 

select a shape from the Masks, only the area it covers will be visible in the Preview window. Everything 

else will be hidden. 
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Draw a mask 

Using the Draw Mask feature, you can create complicated masks in any shape by dragging 

control points and modifying B-Splines. By adjusting the Bessel curve for drawn masks while 

holding the Option, you can easily produce smooth curves. The draw mask can also be saved as a 

preset so that you can apply it with just one click. 
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Adjust the Mask 

To edit the mask, you can also drag the sliders in the Mask tab. Rotate, scale, position, width, and height are 
all adjustable. You can even invert the mask so that the hidden portion becomes visible. 
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7.6 Video Snapshot 

To take a snapshot of a video clip and save it as an image file, just follow the steps below: 

 
  Import the video clip to the “Media Library”. 

  Select the video in the Media Library so you can see it in the preview 

window. 

  Play the video and click the “Snapshot” icon at the desired frame. 
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7.7 Play Video in Reverse 

Here are 2 ways to help you flip your video to play backwards: 

 
First, launch the program and select Create New Project. Then, import your video to Media Library. 

 
Way 1. Uniform Speed 

 
Step 1. Right click the video clip in your timeline and choose Uniform Speed. 
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Step 2. Check Reverse Speed in Speed panel and click OK to apply. 
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Way 2. Speed Panel 

 
Double-click the video clip in the timeline, and choose the Reverse Speed option under the Speed tab. 

Then, follow the process like way 1. 
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Index 

01 Overlay a video to a background video 

02 Transform 

03 Compositing 

04 Motion tracking 

05 Stabilization 

06  

07  

08  

7.8 PIP (Picture in Picture) 

Using video overlays enables you to simultaneously display two or more video clips on the screen. It is a 

useful technique for creating online tutorials, product demonstrations, and gaming videos. 

 

 

 
Overlay a video to a background video 
 

The first steps to make a PIP video is, import 2 video clips into Filmora and drag them to the 

timeline. Remember to put the 2 video clips in different tracks. Double click the preview window. 

Now you can customize the size and region of the overlay video. Then a list of editing options will 

appear in the left corner. 

1. 

2. 
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Transform 

The first editing option is “Transform”. You’ll see several option under this part, including rotate, flip, 

scale and position. You can select the overlay video to rotate it to a customized angel, flip it, scale the size 

and change the position.
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Compositing 

Click into the Compositing tab and select compositing to blend your main video with your PIP clip. You 

can adjust your opacity depending on how intense or subtle you want the effect to be. 

 

 

Motion tracking 

The “Motion Tracking” feature is also available in PIP video, check how to apply motion tracking to video. 

 

Stabilization 
 
Stabilization is used to adjust the smooth level and edge processing of the video, check how to use 
stabilization in Filmora. 
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Apply green screen 

You can also apply green screen effects to picture in picture videos to enhance to a new level. The 

settings includes color, offset, tolerance, edge thickness, edge feature and alpha channel. Learn more 

about using green screen effects. 
 

 

 

 

Lens correction 

Len correction allows you to select camera profile and resolution, you can also adjust the level. Learn how 

to use lens correction. 
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Drop shadow 

Use the drop shadow includes the distance, blur, opacity, color and direction. Learn how to use drop 

shadow. 
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Index 

01 Choose Split Screen Preset 

02 Import Clips to Split Screen Video 

03 Edit Split Screen Video 

04 Color Correction for Split Screen 

05 Animating your Split Screen 

06 Adjusting Single Video in Split Screen Preset 

7.9 Creating Split Screen Video for Mac 

You can easily create multiple videos simultaneously by using the Split Screen feature. Split Screen is 

popularly used to depict a scene from multiple angles as well as show characters placed in different 

locations having a conversation. 

 

 

 

 

 

Choose Split Screen Presets 

Displaying two or more videos side-by-side when creating content is now the norm. Using Split Screen 

to create a unique way to tell your story is easy by using Filmora. Here are the instructions for using 

Filmora to create a unique Split Screen video on your Mac. 

Step 1: Launch Filmora and click New Project to import your video clips. 

Step 2: From there, click Templates and select Split Screen. Choose from 30 split-screen preset 

templates. You can have as many as 6 clips for simultaneous playback within the screen if you want. 
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Step 3: Once you have selected your Split Screen preset, simply drag it to the Timeline. 

 

 

Note: 

The split screen has a default duration of 5 seconds, which can be adjusted by dragging the 

edges forward or backward on the timeline. 

 
 

 

Note: 

You could scroll up and down on the thumbnail view area with your mouse wheel, for 

example, from “Basic” to “Social Media”, you only need to scroll horizontally. 
 
 
 
 
 
 
 
 
 

 

 
 

 

Import Clips to a Split Screen Layout 
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Edit Split Screen Video 

Editing your split screen videos allows you to make photo and video collages, intro and outros, 

reaction videos, and comparisons with a few clicks. Here’s how to edit your split screen videos for 

a unique way to tell your stories. 

Method 1: Add Borders 

Under the Video tab on your Property Panel, enable Border to customize the color and size of the 

borders around the clips in split screen. 

 

Step 1: Launch Filmora and create a New Project. Click Import to add media files to your library. 
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Color Correction for Split Screen 

 

White Balance: Balance the color temperature in your video. 

Color: Choose the right tone depending on the scene 

Light: Calculate the correction of the colors on your video. 

Vignette: Darken the edges of the frame on your video. 

Color Match: Create a consistent look across your video. 

 
 

Method 2: Change Size and Position 
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Animating your Split Screen 

You can customize your videos with different split screen effects whenever you want. Switch to the 

Animation tab and choose from animation or motion presets by double-clicking your desired 

effect. You can see the results in the Preview Panel before saving the new animation effects on 

your video. 
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Adjusting Single Video in Split Screen Preset 

 

Zoom in and Zoom out: Choose the clip in the split screen preview. Afterward, drag the slider to zoom in 

and zoom out. 

Remove the clip from the split screen video: Select the clip in the split screen preview and click the 

Remove icon to manually remove single videos on the split screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Or you can simply highlight the Diamond icon to set keyframes located beside the properties or 

parameters and then adjust the values as you prefer. The Changes will be applied to all the clips in the 

split-screen video. 

 

 

Note: 

All changes you do apply to all clips in the split screen video. If you want to edit a single clip, 

you should go to the Advance Edit panel. 
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Advanced Split Screen Edit: Click Edit to enter the Advanced Split Screen window. From 

here, you can rotate the clip, change its position or scale, do color correction, and even apply 

motion effects. There’s also an option to trim the video to the area you want to show on the 

split screen. 
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7.10 Mosaic 

Mosaic is a very useful effect in editing videos and images, as it helps to blur the face, logo，and other 

sensitive parts. Below are the steps to use mosaic effect in Filmora on macOS. 

 
Import your video to Filmora and drag it to the timeline, then open the mosaic effect. There are two 

ways to find mosaic, one is, to click the Effects tab and then choose Video Effects > Utility, you’ll see the 

“Mosaic” in the list. 
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Another way is easier, just enter “mosaic” in the search bar，then different types of mosaic effects will 

appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click the mosaic effect in the timeline, and the setting panel will pop out. It allows you to change the 

mosaic position, angle, type, intensity， and opacity in the video. Customize the mosaic to your desired 

status. 
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Now in the preview window, you’ll see the final result of mosaic. 
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The difference between the Mosaic effect and the Face-off effect is that with the Mosaic effect, 

you will be able to blur a stationary portion of your video clip, whereas with Face-off you will 

be able to cover moving faces. 

7.11 Using Face-Off Effect 
 

 
Here's how. 

 

 

Find Utility and Choose Face-off. 

Go to Effects in the top menu and type face-off into the search bar, or scroll through the effects until 

you find Video Effects>Utility. Then choose Face-off. 
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Preview your video 

Drag the Face-Off effect onto the clip you want to apply it to in the timeline. Then, choose either the blurred 
effect or one of the replacement images. You can preview what your video looks like with the Face-Off effect 
by clicking the Play button in the Preview Window. Click OK when you’re done. 
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7.12 Freeze Frame 

Use the timeline zoom controls to magnify the timeline, so you can easily find the frame you'd like to 
freeze. Then, place the play head at that location. Click on the “Speed” icon to change the video speed 
and select the “Freeze Frame” option from the drop-down menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tip. Or you can right-click on the video in the timeline, and then select Add Freeze Frame option from 
the pop-out video context menu. 

 
Choose the “Freeze Frame” from the timeline, and you’ll see 2 options: “Customize Freeze Frame 
Duration” and “Delete”. 
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Choose “Customize Freeze Frame Duration,” and you’ll see a new window. Now you can adjust the 
settings to meet your requirements. 
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01 Add Drop Shadow to Image and Video 

02 Add Keyframes on Drop Shadow 

7.13 Applying Drop Shadow for Mac 

This guide will show you how to apply the drop shadow feature on a video. 

 
Drop shadow is an effect that is commonly used in photo and video editing. It is created by separating the 
subject and/or object from the background and adding a custom shadow. 
 
 

 
Add Drop Shadow to Image and Video 

Here are the steps for adding the drop shadow feature to your image or video. 
 
Step 1: Add the media to the timeline 

Launch the application. Then, import your video from the stock to the timeline, and drag the PIP video or 

image to the above track. Adjust the size, position, and mask of the PIP video accordingly. 

Step 2: Activate the drop shadow feature 

Click the PIP clip in the timeline. A pop-out window will appear on the right side of the interface. In the 
Video>Basic section, scroll down to find Drop Shadow. Click the button beside Drop Shadow to 
activate the feature. 
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Step 3: Adjust settings 

 Adjust the settings of the drop shadow. You can choose the Type of drop shadow between Soft, 
Regular, or Retro. 

  Rotate the dot in the circle to set the angle of the drop shadow. 

 If you need to change the color, you can select an ideal color from the drop box of Color. 

 Then, change the value of Distance, Blur, and Opacity to meet your needs. 

When you are done, click Ok in the bottom right corner of the window. 
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Add Keyframes on Drop Shadow 

You can apply keyframes if you want to add the drop shadow in only a short part of the video or add the 
changes to the drop shadow. The following are detailed steps. 

Step 1: Add the start keyframe 

Drag the playhead back and forth to where you want to set the start keyframe. After adjusting the 
settings of the drop shadow, click the diamond icon beside the feature. 
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Tip: If you click the diamond icon beside Drop Shadow in the toolbar, then all features of Drop Shadow 

will be set in the keyframe. 
 
Step 2: Add more keyframes 

Then, repeat the above steps to add as many keyframes as you like in the video. Please note that there 
must be at least two keyframes. One for the start and the other for the end. When you are done, click Ok. 

 
Filmora will analyze the differences between the keyframes and automatically form the natural animation 
effect. 
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7.14 Auto Enhance 

If you have a video that is not of good quality, using Auto Enhance will help improve it. Here’s how to 
enhance automatically your videos with this feature. 
 
Click the video from the timeline once imported, and a pop-out window will appear in the upper right 
corner. Scroll down and find Auto Enhance. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Now you can adjust the amount by dragging the white line, and click “OK” once you make the perfect 
video quality. 
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7.15 Borders 

Adding borders is for the Split Screen feature. 
 

Choose the Split Screen template you would like to use under the Templates tab. 

Drag your videos onMediato the split screen. 

Enable the Border option to add borders around the clips in your split-screen. 

You can adjust the color and size of the border. 
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7.16 Apply Transforming for Mac 

This guide will show you how to use the transform feature in Filmora to accelerate video editing. 
 

 

 
Step-by-step Guide on How to Activate Transform 

Here are the steps for activating the transform feature. 
 
Step 1: Add media to the timeline 

Launch the application first. Import the video from your computer to the stock or drag the file to the 

timeline. 

Step 2: Activate Transform 

Click the clip in the timeline. Then, the property panel will appear on the left side of the interface. Click 

Video>Basic. After that, click the button beside Transform to activate the feature. 
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Four Uses of Transform 

Here are four uses of the transform feature. 
 
1. Resize Videos 

Scale is used to resize the video. Drag the slider of X to change the width and the slider of Y to change 
the height. 
The width and height would be changed in the origin ratio together by default. You can click the lock 

button if you want to change one of them separately. 

2. Rotate or Flip Videos 

Under the Flip tab, there are four choices, You can click the Horizontal, Vertical, Clockwise, or 
Counterclockwise icon to rotate the clip. Otherwise, insert a value in the box beside Rotate, or drag the dot 
in the circle, to adjust the angle of the clip. 

3. Change Position 

If you want to change the location of the video, you can apply the Position feature. 
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4. Add Keyframes 

If you want to add customized animation of transforming in some parts of the video, you need to apply 

keyframes. The following are steps to add keyframes. 

Step 1: Add the start keyframe 

Drag the playhead to where you want to add a start keyframe. After adjusting the clip, click the diamond 
icon beside the features. 

 

 

 
Note: If you click the diamond icon beside Transform on the toolbar, all the features in this section will 
be added to the keyframe. 

Step 2: Add other keyframes 

Repeat step one to add more keyframes. You can add many keyframes as you want. The minimum number 
of keyframes to complete the animation is two, one for the start and the other for the end. 

 
When you are done, Filmora will analyze and output a natural animation, connecting the different 
keyframes. 
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7.17 Compositing 

Compositing lets you combine multiple video clips together and make it one. You can adjust the 
Blending Mode and Opacity of the target video in Filmora for Mac. 

How to use compositing in Filmora for Mac? 
Click the video to be composed and go to the Property Panel placed in the right upper corner. 

Under Video > Basic, scroll down to find the Compositing option. 

Choose one of the Blending Modes or adjust the video opacity. 

Click OK to save the changes. 

1 

2 

3 

4 

Add Keyframes 

 

151 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


 

 
Index 

01 A Detailed Step Guide 

7.18 Stabilization for Mac 

This guide will show you how to apply stabilization to your video on Mac. It allows you to smooth out shaky 
footage. 
 
 

 
 
A Detailed Step Guide 

 
Here are detailed steps to apply stabilization when editing a video. 

 
Step 1: Import the video 

 
Launch the application first. Then, click Import Media or drag the clip to the library. You can also directly 
drag the video to the timeline. 

 
Step 2: Activate the stabilization feature 

 
Click the video in the timeline, and then the property panel will appear on the left side of the interface. 
Click Video>AI Tools. After that, click the button beside Stabilization to activate the feature. Filmora will 

start analyzing automatically. 
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Step 3: Change the settings 

 
After analysis, you can drag the slider or insert a numerical value in the box beside the slider to adjust the 
Smooth Level. 

 
Edge Processing is used to change the edges of your stabilized video. You can set the edge processing 
to Extend, Reflect, or Tile. 
 

 
You can preview the result until satisfying. When you are not satisfied with the changes, click Reset and 
then all the values will revert to the default. 
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7.19 Change Speed 
Speeding up or slowing down a video is commonly used in editing. Here we will show you how to change 

video speed in Filmora on Mac. 
 

 

 
Change Video Speed with Uniform Speed 

Using the Uniform Speed feature, you can adjust the speed of the selected clip to the same rate. 
 
Get to the Uniform Speed Panel 

Choose the video in the timeline and click the Speed icon from the toolbar above it. Select the Uniform 
Speed option. 
 

 
Change Video Speed to Constant Speed 
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Drag the Speed slider to the right or left to speed up or slow down the playback speed. Optionally, you can 
enter your preferred value in the Duration field to get a more precise output. 
 

 
Preview the Video and Save 

Click the Play button in the Player or press the Space key to preview the modifications. 
 
Note: 

It is recommended to enable Maintain Audio Pitch option to keep the video's audio sound natural. 
 

Modify Video Playback Speed with Speed Ramping 

In addition to constant speed changes in Uniform Speed, you can create variable speed effects with 
Speed Ramping, where a clip's playback speed changes dynamically. You can set up different playback 
speeds for each portion of the video. 

Go to the Speed Ramping Panel 

Click the Speed icon again, and select the Speed Ramping option, and then you will see a couple of 
options in the property panel on the right side of the interface. 
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None: Apply no speed ramping. 

 
Customize: By default, five-speed points allow you to customize the speed exactly the way you want. 

 
Montage: Six speed points in the playback speed of the selected video: 0.9x, 0.9x, 6.9x, 0.3x, 1.0x, and 1.0x, 
which present a slow, slow, fast, slow, and normal rhythm. 

 
Hero moment: Eight-speed points in the playback speed of the selected video: 1.0x, 1.0x, 5.4x, 0.5x, 0.5x, 
5.4x, 1.0x, and 1.0x, which present a normal, fast, slow, slow, fast, and normal rhythm. 

 
Bullet time: Six-speed points in the playback speed of the selected video: 5.2x, 5.2x, 0.5x, 0.5x, 5.2x, and 
5.2x, which present a fast, fast, slow, slow, fast, fast rhythm. 

 
Jumper: Five-speed points in the playback speed of the selected video: 0.6x, 0.6x, 6.0x, 0.6x, and 0.6x, 
which present a slow, slow, fast, slow, slow rhythm. 

 
Flash in: Four-speed points in the playback speed of the selected video: 5.2x, 5.2x, 1x, and 1x, which 
present a fast, fast, normal, normal rhythm. 

 
Flash out: Four-speed points in the playback speed of the selected video: 1x, 1x, 5.2x, and 5.2x, which 
present a normal, normal, fast, fast rhythm. 
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Select and Customize Speed Ramping Preset 

Please select one of the presets to apply variable video speed and customize it based on your needs. 
Variation in the speed will remain effective until the Play head reaches the next speed point. The speed of 
the video will gradually change as the Play head moves between the speed points. 

 
Adjust the speed of the section: Drag the speed point up or down to increase or decrease the speed of 
the section. 

 
Adjust the range of the section: Drag the speed point left or right to change the portion applying the 
speed. 

 
Add speed point: Place the play head to the point you want to change the speed, and then click the Plus 
+ icon on the left to add a speed point. 

 
Delete speed point: Select the speed point and click the Plus – icon to remove it. 

 
Add a freeze frame: Place the play head to the point you want to freeze, and then click the snow icon to 
add a freeze frame feature. Set up the freeze time and click Apply to save. 

157 of 349



 

 

 
Preview the Video and Save 

Press the Space key or click the Play button in the Preview window to preview the modifications in the 
video. If you want to remove the settings, click Reset. You can also save the speed ramping setting by 
clicking the Save as a custom button. 
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Note: 

If the Uniform Speed and Speed Ramping options are not visible, try upgrading Filmora to the latest 
version. 

Change Speed in Timeline 

You can also change the speed in the following paths: 

 
Right-click the video in the timeline and select Uniform Speed or Speed Ramping on the context 
menu. 

 
  Choose directly the speed options (0.01x to 100x) from the Slow or Fast menu above the Speed icon. 
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7.20 Lens Correction 

Filmora provides a practical feature for editing action cam footage. That is Lens Correction! It will help to 
adjust the lens of the camera in an easy way. Here’s how to use it: 
 
Click the video from the timeline (assuming you’ve already imported it), and then find Lens Correction 

from the property panel. Click the tab to activate the correction feature. 
 

 
Then you can select the camera model, Click the scroll-down icon and you’ll see the list of available camera 
models. 
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After selecting the camera model, you can now choose the desired resolution from 4K SuperView to 720p 

Wide. You can adjust the correction level by dragging the Adjust Level slide bar. 
 

 

Remove Lens Correction Settings 
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To remove the set feature, you can click the reset icon on the right side of the Lens Correction section 
title or its parameters. Then, the values will revert to the default. Or click Reset at the bottom to remove 

all the settings you’ve made here. 
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7.21 Uniform Speed 

There are two different ways you can change your video or audio speed in Filmora for Mac. 

 
Method 1: Right-click on a clip in the timeline and select Uniform Speed. The Custom Speed window 
will pop up. Drag the speed slider to make your video faster or slower. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Next to the speed slider, you'll see a speed box where you can type in a precise speed value. You make 
your clips up to 100 times faster or 0.01 times slower. 

 
Method 2: Select your clip in the timeline and click on the Speed Icon in the toolbar. Select Custom 
Speed, Slow, or Fast from the drop-down menu. 
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7.22 Speed Ramping 

There are 6 preset modes in Filmora Speed Ramping to level up videos. You can also customize the speed 
ramping of videos or audios based on your need. 

 
Right-click on the clip to Choose Speed Ramping. Or Click the Speed Icon then select Speed Ramping. 
 

Apply or Customize Speed Ramping 
 

Apply the Montage, Hero moment, Bullet time, Jumper, Flash in, or Flash out to your video or audio 

clip. Or you can choose to customize the speed ramping settings. 
 

 

 
Adjust Audio Effect 
 

When applying the speed ramping to the audio clip, you can click the Maintain Audio Pitch to adjust 
the audio effect. 
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7.23 Adjustment Layer for Mac 
This guide shows how to add one layer to adjust several clips. The effects applied to an adjustment layer 

affect all layers below it in the layer stacking order. You only need to edit the layer, dragging the transitions 
and effects on the layer, to apply the effects to the layers below it. 
 
 

 
Usage Scenarios 

The adjustment layer can make the same adjustments to however how many clips are under it all at once. 
By editing the layer mask, it's more convenient to make adjustments or remove the feature. It allows you to 
edit a single layer when re-editing, instead of complicatedly adjusting different parts of videos. 

Apply Adjustment Layer to Videos on Mac 

Follow the detailed steps below to see how to activate this feature. 

 
Step 1: Import media 

 
After launching the application, you can import the video from your computer or the library. Then, drag the 
clip to the processing interface. 

 
Step 2: Launch the Adjustment Layer 

 
Click My Media>Adjustment Layer>Preset to process a new task. Alternatively, you can modify your saved 
presets in Custom. Then, drag the Adjustment Layer to the timeline above the video clip. 
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Step 3: Change the detailed settings 

 
Drag the Adjustment Layer in the timeline back and forth to perfectly match the duration of the video. 
 

 
Then, one-click to open the settings interface on the right of the screen. When you are done, click Ok. 
There are two settings options: Layer and Color. 

 
The Layer settings include basic modifications, such as Scale, Position, Flip & Rotate, Rotate, Blend 
Mode, and Opacity, as well as Animation. 

In terms of Color, you can apply various built-in presets and change the White Balance or set Color, 
Light, Vignette, and Color Match. 
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Step 4: Add more effects 

 
Click Effects in the toolbar at the top of the interface. Besides a variety of Default choices, you can find 
whatever you want in Filmstock. 
 

 
Drag your needed effect to the Adjustment Layer in the timeline. After that, the effect settings are available. If 
you need to adjust the effect, click the layer in the timeline. Then, the settings window will appear on the left 
side of the interface. 

Delete This Feature 
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To delete the Adjustment Layer feature, you can select the clip in the timeline, right-click on your mouse, 
and click Delete. 
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7.24 Trim/Split/Cut Out Audio 

The video trimming, splitting, and cutting is just one-click far on Filmora. You can do this easily with your 
video clips by moving the slider, too! 

Trim Audio Clips 
If you need to trim from the beginning or end of an audio clip, hover your mouse over the left or right edge 

of the clip in your timeline until the trim tool shows. Then, click and drag the edge of your clip forwards 
or backward to trim the unwanted portion. 
 

 
Filmora also has an option for you to trim from the start or end of a clip quickly. Go to the “timeline,” and 
place the playhead on the frame you want to trim. Right-click on the clip and select “Trim Start to 
Playhead” or “Trim End to Playhead”. You can choose what you want to delete, behind the playhead or in 
front of it. 
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Split Audio Clips 
Select your audio clip and place the playhead where you want to split it, then right-click on the clip and 
select “Split” or click the “Split icon” above on the toolbar. 
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Cut Out Audio 
If you want to cut out a section in the middle of an audio clip, drag the playhead to the start point of the 
unwanted section and press the “Scissors” icon to split the clip, then drag the playhead to the end of the 

unwanted section and press the “Scissors” again. Now that the unwanted section is on its own, you can 
select it and press the “Delete” icon to remove it. 
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7.25 Adjust Audio 

To adjust your audio, double-click on the audio clip you want to work on in the timeline to open a panel 
with adjustment sliders for volume and pitch. 
 

 
Now, a new panel presents audio settings, including fade in, fade out, pitch, equalizer, denoise, and 
ducking. 
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For a more advanced audio editing experience, you can also access the “Audio Equalizer” from this panel. 
You can choose from presets or make manual adjustments by clicking on “Customize” in front of Equalizer. 
 

 
Switch to the “Speed” option, and you can change the audio speed, duration, reverse speed, ripple edit, 
and maintain audio pitch. 
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You can also switch to “Speed Ramping” to select the type you want. Learn more about Speed Ramping.
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7.26 Pitch 

Audio pitch is another option to adjust your audio file, especially when you want to speed up or lower 
the volume. To change the audio pitch on Mac, just follow the steps below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
After importing audio to the timeline, and you’ll see the audio settings. Navigate to the “Pitch” button 
and drag the slider to the right to set the pitch up. 

 
 

 
 
 

 
 
 

 
 
 

 
 

 
 
 

 
 
 
Then check the timeline and see if it meets your needs, click “OK” to apply the adjustments. 
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7.27 Fade In and Fade Out 

To add Fade In or Fade Out effects to an audio file, you'll first have to place it on the timeline. Click the 
audio clip to gain access to the Audio settings panel and then drag the Fade In and Fade Out sliders to 
the right to add fade effects and set their durations. 
 

 
Drag the fade in/out bar to the right and you’ll see the effects from the timeline.
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If you do not find the Auto Sync tab on the toolbar, click the Custom toolbar icon on the far 
left. You can drag the Auto Synchronization button into the toolbar. 

7.28 Auto Synchronization 

Using audio sync will make it effortless to match your audio with your video, making it sound clearer. You 

try this feature by following the steps: 

❶ Method 1. Select the Video + Audio with the audio track on the timeline simultaneously. Hover the 
mouse over the Auto Synchronization button on the toolbar above the timeline, and it will show tooltips 
to remind you of the function summary. 
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❷ Method 2. Select the video + audio with the audio track simultaneously on the timeline. Click “Tools” 
on the menu bar and select “Auto Synchronization.” 

 

 
🅔 Method 3. Select the video (with audio) and the audio track on the timeline simultaneously. Right- 
click and select “Audio Synchronize.” 
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If the selected clips cannot be synchronized, a pop-up window will prompt, "The 
selected clips cannot be synchronized; please reselect the clip." Click "OK" to close 
the popup window. 

 
 

 

 
❹ If you click the "Cancel" button, the audio and video will stop analyzing, and the pop-up window will 
be closed. 
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The button cannot be clicked when more than two video and audio clips are 
selected. 
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7.29 Equalizer 

All videos have an abundance of different sounds like music, speech, or sound effects. Changing the 
strength of sound waves will enable you to mix these sounds together into a coherent soundtrack. 
 
In the audio track, choose “Adjust Audio” to enable the panel. You can find the Equalizer, it contains 
Default, Classic, Rock'n'Roll, Techno, Bass, Sparkle, Hard Rock, Pop, Ska, Acoustic, Blues, Folk, Country or 
Custom. 
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Click on the “Setting” button located next to the drop-down menu to adjust the Audio Equalizer 
manually. You can make the adjustments by dragging the sliders up or down until you find the desired 

value for each of them. Hit OK to save your settings. 
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7.30 Detach Audio 

To detach audio from a video in Filmora, just follow the below guide: 
 
Add the clip to the Timeline, right-click to open the menu, and choose the “Detach Audio” option. The 
proficient tool will automatically detach the audio from the video and place it in an audio track on the 
timeline. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
You can now easily edit or delete the audio track without affecting the attached video clip. 
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7.31 Mute The Audio Clip 

To mute the audio in a video clip, right-click on the clip in the timeline and choose “Mute”. 
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7.32 Detect Beat and Create Beat Markers 

Filmora’s Beat Detection function will mark audio beats automatically and make it easier to match your 
video. Here are the steps to use Beat Detection. 

Creating Markers with Beat Detection 
Right-click on a “Music” file that you want to detect the beats for. You can choose from the built-in 

music or your own imported audio files. Select “Beat Detection” in the context menu. When the analysis is 
finished, a Beat icon will appear on the music’s thumbnail. 
 

 

 

Filmora will need to install the beat detection plugin for the first time you use Beat Detection. 

It may take some time. 
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Drag and drop your analyzed music file into your timeline to see the beat markers. 
 

 

Beat Options Setting 
Filmora will display highlight beat markers in red every four beats by default, but this setting can be 

changed. You can change the beat detection settings by right-clicking the “Music” file in the library. 
Then select “Beat Options.” Here you can change the highlight beat frequency, highlight offset, or un- 
check Mark highlight beats only to display every beat marker. 
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Adding Additional Beat Markers 
Select your audio file in the timeline and place the playhead where you want to add a marker. Then, click 
the “Marker” icon or press “M” on your keyboard. 

Removing Beat Markers 
Choose a marker and press “Delete” on the keyboard, or right-click on the marker and choose “Delete.” 
To remove all markers, choose “Delete All Markers.” 

 
Once you’re happy with how the beats are marked, all that’s left is to drag and drop photos and videos into 
the video tracks and arrange them to match the beat. 
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7.33 Audio Mixer 

The Audio Mixer lets you adjust the dB levels of all your tracks that contain audio and set whether they're 
set more to the right or the left. 

 
To use the Audio Mixer, follow these instructions: 

 
Drag and drop all your audio files (including video files from which you will be using the audio) into 
the timeline. 

Click the “Audio Mixer” icon in the toolbar. 
 

 
Drag the small ball along the circle (the Pan/Balance knob) for each track to switch the sound 
between the left and right channels. You can also move the circles on the gauges upwards or 

downwards to adjust the gain. 

190 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


Printed with Pdfcrowd.com  

 

If you select Surround, you'll be able to pan from left to right and from back to front, while in 
the Stereo mode, you can only pan from left to right. 

 

 
You can choose between “Surround” and “Stereo” on the right side of the window. You can also 
drag the corresponding tracks to where you need them, along with the Pan. 

 

 
 
 
 
 
 
 
 

 
  Click "OK" to apply your changes to your video. 

 
The Audio Mixer also lets you control the Master volume by dragging the sliders up or down so you can 
choose how loud a video clip should be. Click on the “Play” button to hear the results, and click “OK” to 
apply your adjustments. 
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7.34 Audio Stretch for Mac 

Among many diverse functions Filmora offers is its Audio Stretch feature. This feature allows editors to 
alter the duration of an audio track to align seamlessly with the video clip. There are no technicalities 
involved, as users can increase or decrease the duration of an audio using their mouse. For an in-depth 
detail of this feature, read the following guide: 
 
 

 
Enabling the Audio Stretch Function 

From Filmora's main interface, there exist two methods to employ the Audio Stretch function, and here is a 
precise instruction manual ability to activate it: 
 

Method 1: Via the Timeline Tools Panel 

Step 1: Initiate a New Project 

First, download the latest version of Filmora on your device and launch it. Upon the appearance of its main 
display, click the "New Project" tab to start with. 
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Step 2: Import Media and Separate Audio 

Initiate the editing process by importing your media content into its Media Library and placing it on a 
timeline. Keep in view that it is important for a video file to contain audio. Following this, select the clip 
and press "Command + Click" from your keyboard. From the selection panel, click the "Detach Audio" 

option to separate the audio track from a video. 
 

 
Step 3: Activate the Audio Stretch Feature 

Now, move your cursor towards the detached audio track within the timeline, select it, and from the 
timeline interface, select the "Audio Stretch" option. Now, experiment with your cursor to change the 
settings. 
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Method 2: Via the Keyboard Shortcuts 

Another way to access the Audio Stretch functionality is by selecting the detached audio clip within the 
timeline and pressing the "S" key on the keyboard. 
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7.35 Audio Effects 

There are many sound effects resources in Filmora. You can find them in Audio> Sound Effect. 
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7.36 Adjust Tones for Mac 

When using Filmora, you can harness the power of many options to enhance its color tones. This 
function grants users easy access to tweak color tones by adjusting sliders or modifying the color 
element values. In this guide, you’ll discover the built-in presets and other color tone adjustment 
features: 
 

Adjusting Color Tones in Filmora 

Enabling this feature is child's play, and here's how you can employ it during editing by following these 
provided steps: 

Step 1: Importing the Clip to the Timeline 

To begin, download Wondershare Filmora, launch it, and locate the "New Project" button in the main 
display window. After creating a new project, import your clip into the Media Library using the "Command+ 
I" keyboard shortcut. Then, employ the drag-and-drop functionality to place your clip on the timeline 
and select it. 
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Step 2: Accessing the Color Tab 

Following the previous step, proceed to the left-side panel and access the "Color > Basic" tab. Here, 
you’ll find a variety of color tone adjustment elements, including "Presets", "LUT", "Color", "Light", and 
more. 
 

 
Step 3: Saving the Color Tones

After adjusting, preview your video to ensure the results align with your expectations. To 
preserve these custom edits, click the "Save as custom" button. To reset the existing settings, click 
the "Reset" button at the bottom. 
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How to Access the Light Adjustment Feature? 

The question of accessing the Light settings within Filmora's interface remains still. This step-by- 
 

Step 1: Adding Media to the Timeline 

access the 
editing interface. Then, drag and drop the imported media into the timeline using  

7.37 Light Adjustments for Mac 

Modifying the light elements in your media is important as it impacts the clarity of objects and the overall 
quality of your content. Filmora offers a range of adjustment options within the light section, allowing 
users to fine-tune the settings according to their preferences. In this guide, you will learn about the 
aspects to modify in the light section: 
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Step 2: Enabling the Light Option 

Select the video in the timeline and navigate to the settings panel on the left side of the editing 
window. Within the "Color > Basic" tab, scroll down until you locate the "Light" section and activate it. 
In this section, you can adjust elements such as "Exposure", "Brightness", "Contrast", "Highlight", 
"Shadow", "White", and "Black". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
Step 3: Saving or Resetting 

After adjusting, use the "Save as custom" option to preserve your settings or click the "Reset" button to 
readjust them. 
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7.38 Sharpen for Mac 

Filmora's sharpness feature empowers users to bring clarity to their content and enhance the definition of 
objects. While it's not an independent function, accessing it is straightforward. By exploring this guide, you'll 

gain the knowledge needed to sharpen objects in your videos: 
 

 

How to Access the Sharpness Option? 

In this section, we've outlined a step-by-step procedure for accessing and adjusting the sharpen feature in 
Filmora: 

Step 1: Import Media into the Media Library 

Initiate Wondershare Filmora after installation, and upon reaching its main interface, create a "New 
Project". Using your keyboard, invoke the "Command + I" buttons to begin the import process. After 
importing your files into the Media Library, employ the drag-and-drop functionality to position them 
on the timeline. 
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Step 2: Locating and Enabling the Sharpen Option 

Next, select the timeline clip and access the "Color" settings within the left panel. Here, scroll until you 
find the "Adjust" slider, and enable it. Then, expand it to reveal the "Sharpen" slider. By adjusting the 
slider forwards and backward, you can control the intensity of this effect. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Step 3: Saving or Re-Adjusting Settings 

To preserve these settings for future use, click the "Save as custom" button or press the "Reset" button to 
return to the editing process from the start. 
 
 
 
 
 
 
 

 
 

 
 
 
 

 
 

201 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


Printed with Pdfcrowd.com  

 

7.39 Vignette Effect for Mac 

Vignette is a widely-used effect, mainly known for adding a touch of nostalgia or past to your images 
and videos, and you can achieve this effortlessly with Wondershare Filmora. This effect allows users to 
edit their media and capture viewers' attention with its outlook. To delve deeper into this feature, 

continue exploring this guide below: 
 

 

How to Access the Vignette Effect? 

This section discusses the steps for accessing and enabling the Vignette effect in Filmora while also 
exploring its aspects: 

Step 1: Begin a Project and Add Media to the Timeline 

Upon launching Filmora on your desktop, initiate a new project by selecting the "Open Project" button, 
and then import your desired file directly into the Media Library. Afterward, place your media on the 

timeline and select it. 
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Step 2: Enable the Vignette Effect 

Upon completing the previous step, a customization panel will appear on the left side of the screen. 
Using your cursor, navigate towards this panel, and under the "Color > Basic" tab, scroll down to locate 
the "Vignette" effect. Once found, enable it and adjust the settings below as per your video 
requirements. Users also have the flexibility to customize the parameters under the vignette. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
Step 3: Save the Vignette Settings 

To readjust the vignette parameters, click the "Reset" button to revert the changes. After completing 
your editing, save your customized settings by clicking the "Save as custom" button at the bottom of 

the customization panel. 
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7.40 HSL for Mac 

Filmora offers various color correction and adjustment features, including the HSL function. This feature 
allows users to fine-tune colors using three components: "Hue," "Saturation," and "Lightness." The 
primary focus of this guide is to provide instructions on how to access and enable the HSL feature in just a 
few clicks: 
 

 
 
 
Step 2: Activate and Access HSL Settings 

Next, select the video you've placed on the timeline and navigate to the "Color > Basic" tab within 
the left-side panel. Click on the "HSL" tab, and from there, you can adjust the settings of the "Hue", 
"Saturation", and "Luminance" sliders. 

How to Access and Enable HSL in Filmora? 

There is only one method to access this feature within Filmora, and the following step-by-step guide will 
walk you through it: 

Step 1: Import Media for Editing 

Upon launching Filmora, click the "Open Project" button to access the import files in the timeline and the 
main interface. Once you select the files from your device, they'll be automatically added to the 

timeline. 
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Step 3: Saving or Resetting the Adjustments 

After making the desired adjustments, click the "Save as custom" button at the bottom of this 
panel to save these settings. To modify these settings for a better outcome, press the "Reset" 
button. 
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04 Method 4: Through Color Settings 

7.41 Color Comparison View for Mac 

In the pursuit of editing, color maintenance upholds the integrity of your content, and Filmora presents its 
Color Comparison View for you to master color editing. This feature allows users to compare their video 
content's original and post-editing outlooks. For a detailed guide on understanding the Color 
Comparison functionality in Filmora, read below: 
 
 

 
Accessing Color Comparison View on Filmora 

To separate the differences in your clips, you can employ any of the following three methods that suit 
your preferences the best: 
 

Method 1: Via the Upper Toolbar 

Step 1: Place Media on the Timeline 

Once you have created a "New Project" within Filmora after its launch, proceed towards the import 
of your files using the "Command + I" keys. After importing, use your cursor to select and drag the 
imported media onto the timeline. 
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Step 2: Activation of the Color Comparison Feature 

After selecting the clip in the timeline, direct your attention towards the top toolbar and select the 
"View" tab. From the appearing dropdown menu, select the "Compare Color Before/After" option. 
Further, select the layout style for the color comparison window from "Side-by-Side View", "Split 
View Left/Right", and "Split View Top/Bottom". 
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Step 3: Editing Within the Color Comparison Mode 

Once the layout has been customized, a new window displays the color comparison between 
your pre and post-edited video. You can observe or enhance the changes from there and exit 
this window by clicking the "Color Comparison Layout" icon at the color editing panel. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

Method 2: Via the Settings Panel 
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Method 3: Via the Timeline Toolbar 

 

 
 

After the import of media in the timeline panel, select it directly towards the "Color" tab at the 
left settings panel. From there, expand the "Color Comparison Layout" icon and choose a 
layout to activate this view. 

209 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


Printed with Pdfcrowd.com  

 

 
Method 4: Through Color Settings 

Another method that you can consider for comparing the color within a video clip is through the "Color" 
settings. As you select the clip and continue into the respective section, scroll down and enable the "Color 
Match" option. Proceed to click the "Comparison View" button to enable the comparison view settings 

for Filmora. 
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7.42 Histogram for Mac 

Filmora ensures the seamless color editing process with its Histogram feature. The histogram is a 
significant tool for monitoring color corrections and preserving the visual quality of the video. In this 
informative guide, users will acquire the knowledge required to access Filmora's histograms and tailor 
their layouts for optimal functionality: 

Access and Personalize Histograms 

The following section outlines the steps for accessing and personalizing histograms within  

Step 1: Import Media to the Timeline 
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Step 2: Accessing Histograms 

Once your video is on the timeline, select it, move toward the preview screen, and click the "Video 
Scope" button located at the top right of the preview section to access its features. 
 

 
Step 3: Personalize the Histogram Options 

Customize the video scope layout to a single view from the top right corner. Moreover, expand the 
"Type" navigation, and from the dropdown menu, select "Histogram" to observe the color preview. 
Furthermore, you can switch between histogram channels, including "RGB" and "YRGB".
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01 Speech to Text (STT) 

02 Text-to-Speech (TTS) 

03 SRT 

04 Tips to Use STT/TTS Function 

Speech to Text (STT) 

Methods to Use the Function 

Method 1 - Select audio asset in the timeline, click Tools > Audio > Speech-to-Text. 

8. Text & Subtitle 
 

8.1 Speech to Text/Text to Speech/SRT on Mac 

Learn dubbing and subtitle editing enhancing methods in this guide. 
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If there is no supported file type on the timeline, the Speech to Text icon 
does not appear 

 
Method 2 - Select the video/audio in the Media resource area, right-click, and see 

Speech to Text. 
 
 

 
 

       Method 3 - Select the audio asset in the timeline. In the toolbar, you will see Speech to 
Text. 
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  Method 4 - Select the audio on the timeline, right-click and select Speech to Text. 

 

 

 
 Parameter Settings 

 In the Speech to Text parameter selection tip, you can select the language of the audio to 
be transcribed and files to be converted. 

 

 

 
 Task List 
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Text to Speech (TTS) 

Methods to Use the Function 

Method 1 - Select title assets in the timeline and click Tools > Text to Speech. 

 
 

In the list of voice-text services, you can see the file name, duration, and status. 

File Generation 

The generated file will be displayed in SRT format. 
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Method 2 - Select the title asset in the timeline, and click the Text to Speech icon in the 

toolbar. 
 
 

 
Method 3 - Select the title asset on the timeline, right-click and select Text to Speech. 
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Remember to tick "Transcriptions are automatically matched to the timeline" if you 
need. 

 
 

 
 Parameter Settings 

  Select the language this title is in and the voice name in the TTS parameter setting bar. 

You can also adjust Speed and Pitch by moving the left and suitable scroll bars. 
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 Task List 

  Double click on the completed list and the generated file will be highlighted. 

File Generation 
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SRT 

How to Import and Edit 

SRT files exported by other tools can be imported into Filmora for editing, which provides more 
 

You can also select the SRT items and convert it to various voices in one click. 

Import SRT subtitle files directly from the Media resource area. 
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You can edit time code, change subtitles, add/remove/merge subtitle strips, and change 
subtitle styles in the Edit Subtitle File pop-up window. 

 

 
Select the SRT file on the timeline, right-click and select Export Subtitle File. 
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Tips to Use STT/TTS Function 

Are the STT/TTS licenses the same as Win and Mac versions? 

No. Like the Filmora license, the configuration is differentiated according to Win and Mac. 

Will the authorization be repeated after STT/TTS recharge multiple times? 

Yes. Different from the extension of the expiration time after multiple purchases of Filmora, the 
unit of STT/TTS is the number of hours/characters, and multiple purchases automatically 
accumulate numerous hours/characters. 

How to do if I want more STT/TTS character packs? 

You can contact customer service directly on the purchasing page . 

 
Will the STT/TTS character balance be deducted if upload/transcription fails? 

No. 

Will the STT/TTS character balance be deducted if the file format is not supported? 

No. 

Will the STT/TTS character balance be deducted if a task is removed during the 
upload/transcription process? 

If the task fails, it will not be deducted; if it is successful, it will be deducted. 
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8.2 Types of Titles 
Filmora makes it easy to create the titles that match your style. You can even add animated text effects 

like dialog balloons. Captions, lower 3rds, subtitles, openers, and end credits are among the text options 
available in Filmora. 
 

 
With Filmora, adding titles and texts to your videos is not a big deal. 

 
Filmora 12 has especially provided a new type of title – 3D title. With stunning 3D text animations, you can 
bring your video to the next level. From metallic, nature, to festival, you can get inspired and create with 
more than 40 3D text effects. Moreover, 3D text effects can be edited in batch to increase your editing 
efficiency. 
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You can explore the “Titles” tab to see different text templates, such as: 

 
 Basic text 

 Titles 

 Openers 

 Subtitles 

 Lower Thirds 

 Callout 

 End Credits 

 Social Media 

 Gaming 

 Education and tutorial 

 Travel 

 Sports 

 Business 

 Food 

 Pets 

 Hollywood 

 Events 

And many more! 

 
That means, whether you are making a video for your business, travel blog, social media, YouTube music 
channel, or anything, you can pick a relevant title/text template from the above categories to make your 
videos more engaging and fun for the audience. 
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8.3 Add Titles 
Filmora for Mac makes it easy to create text & titles that match your style. Captions, lower 3rds, subtitles, 

openers, and end credits are the text options in Filmora for Mac. You can even add animated text effects 
like dialog balloons. In this guide, you’ll learn how to access and use them. 

 
There is a variety of animated text presets you can access under the “Titles” menu. You can customize 
any text effect you find and save it as a new preset. 

Adding text to your project 

Go to the Titles menu, choose a text effect, and drag it into the timeline. You can also right-click on the 

text effect and choose Apply. 

 
You can also enter plain text; it's no animations or extras, just simple text. 
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In the Titles menu on the left side of the screen, you’ll see folders for different types of text effects 
marked Opener, Titles, Lower 3rds, Sub Titles, and End Credits. You can preview each effect by double- 
clicking on it. Drag and drop the effect you want to use into the timeline, or right-click on it and select 

“Apply”. 

Applying for Openers and End Credits 

To add an Opener (also called an Intro), go to the “Openers” menu under Titles of Filmstock and right- 
click on the Opener you want to add. Select “Apply,” and the Opener will be added to a new video track. 
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To add End Credits, go to “End Credits” option under Filmstock of the Titles and right-click on the credits 
you want. Then, select “Apply” from the submenu. 
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8.4 Edit and Customize Text Effects 
There are many preset text effects, however, to make the text more suitable for your video. You can edit 

and customize the text effect with built-in tools. 

Enter text 

Double-click on the text effect in the timeline to open the Text Editing panel and type in your message. 
You can then modify the properties (font, spacing, size, style, alignment, color, and more) of the title 
effect. 
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Click on the Font drop-down menu to change the style of your text. You can also download a font from the 
internet, install it on your OS, and then use it in Filmora. 

 
Note: If you download a font from the Internet, you will have to restart Filmora for Mac before that font 
becomes available in the software's font library. 

Apply preset styles to text 

Go to the Basic tab of the Text Editing menu and click the thumbnails of the preset styles to apply them. 

 
To change the position of text in the Preview Window. 
 
 

 
 
You can set a position for your text by changing the Alignment parameters in the Text Editing panel. You 
can also click and drag your text in the preview window to move it where you want. 
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Adjust the duration of text effects 

The default duration of all the text effects is 7 seconds, but you can change that by dragging text 
effect’s edges in the timeline. You can also click on the “Duration” icon to change the effect’s duration. 

 

 
If you want to change the default duration of all title effects in Filmora, go to the Wondershare Filmora 
menu, click on “Preferences”, and then enter the new default duration beside Effect Duration. 
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Apply or Change Text Animations 

In the Text Editing panel, click on the “Animation” icon under “Titles” tab. Filmora offers more than 80 
different text animations which you can apply by double-clicking on an effect to preview it and then 
click on “OK” to apply it. 
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Advanced Title Editing 
Click on the “Advanced” button in the lower right corner of the Text Editing panel to access the “Title 
Inspector” window. 
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Besides enabling you to add shadows or borders to the text you insert, the Title Inspector also lets you add 
new text boxes by clicking on the Add Textbox icon. In addition, you can add shapes like bubbles and 

arrows by clicking on the Add Shape icon or insert an image by clicking on the Add Image icon. 

Each new element you add will be displayed on the timeline below the preview window in the Title 
Inspector window. 

 
Changing the color or opacity of your text, or adding blur to the text, are also options you can access 
from the Title Inspector window. 

Customizing Text Style 
Besides entering customized text, the Customize tab contains five more options: Text Fill, Text Border, 
Text Shadow, Shape Fill and Shape Border. 

 
Text and Shape Fill: In Text Fill, you can choose from Color Fill, Image Fill or Gradient Fill. While in Shape Fill, 
you can choose Color Fill or Gradient Fill. 

 
 Color Fill: Pick a color to fill your text or shape. 

 Image Fill: Choose from the built-in images or browse to load your own image and have that fill your 
text. 

  Gradient Fill: Set the start and end colors and click an Arrow button to set the direction. 

 
Tip: You can drag the slider below to set the Blur and Opacity (transparency) values. 

 
Border/Shadow: 

233 of 349



 

Add a border around the letters of your text or a shadow behind them. You can drag the Blur slider to 
blur the text-shadow or border or the Opacity slider to adjust the transparency. 

Saving Customized Text Effects as Presets 
Filmora for Mac lets you save customized text effects from the Title Inspector and the Text Editing panel. 
Once you’ve made all the adjustments you want to a text effect, click on the “Save as Custom” button 

located in the lower left corner of either menu. 
 

 
A dialogue box will pop up where you can enter the name of the new preset. 
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The new preset will be saved in the Custom folder in the Titles tab. 
 

Delete Title 
All title effects in the timeline can be removed by selecting them, and pressing the Delete key on your 

keyboard, or by clicking on the Delete icon in the toolbar. You can also right-click on the title effect you 
want to remove from the timeline and select Delete. 
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8.5 Animate Text 
Besides adding basic text or applying preset text styles, you can also animate text with simple steps. 

There are 80+ animation presets available in Filmora. 

To Apply Text Animations 

After you add text onto the video on the timeline. You can apply text animation through different ways. 
 

 
Double click the text track on the timeline and the above screen will switch to text editor. There are two 
sub-tabs: Basic and Animation, under the Titles tab. 

 
Switch to the Animation tab in the Text Editing panel, double click on the animation you want to try, and 

watch the Preview window to see what it looks like. 
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To customize the animation, you can adjust the options in Transform and Compositing panel. Finally, 
click OK to apply the animation to your title. 
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8.6 Text Presets 
When you edit text on the text editing panel, you can find that Filmora which provides many preset text 

styles. You can apply these preset texts to the video with a few clicks. 
 

 
To find preset text, you can double-click the text track or right-click on it and choose “Edit Properties”. 
This helps in listing different text styles on the left of the text editing panel. After you choose one, you can 

still modify the style by adjusting the options, including fonts, text color, line space, opacity, rotation, scale, 
etc. 
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01 Method 1: Via Timeline Toolbar 

02 Method 2: Via Custom Toolbar 

8.7 Advanced Text Edit for Mac 

Filmora V13 elevates the text in your videos through its remarkable Advanced Text feature, allowing 
users to elevate text in diverse ways. This functionality allows users to apply diverse animations and 
present their textual elements while accessing further customizations. To access and harness this 
feature, see the guide below: 
 
 

 
Employing the Advanced Text Edit 

Here are the step-by-step instructions to start and employ Advanced Text Edit crafted below: 
 

Method 1: Via Timeline Toolbar 

Step 1: Initiate a New Project and Access the Quick Text Option 

After launching the Filmora software on your device, click the "New Project" option located on its main 
display. Upon entry into Filmora's editing interface, direct your mouse toward the timeline toolbar and 
discover the "T" icon. Click upon any of the options presented within its dropdown menu. 
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Step 2: Access the Advanced Text Edit Function 

On enabling "Quick Text", a title will be added to your timeline. Select this title, navigate towards the 
settings panel, and select the "Advanced" option at the bottom. 
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Step 3: Start Editing in the Presets Tab 

In the Advanced Text Editing window, select the "Preset" tab from the right-side panel and 
apply an appropriate preset to your textual creation. 

 

 
Step 4: Customizing the Text Elements 

Following this, go to the right-side panel and select the "Customize" tab. Under this tab, a 
multitude of customizations become available, including text "Fill", "Gradient", "Opacity", and more. 
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Step 5: Infusing Animations into Your Text and Saving 

Upon accessing the "Animation" tab within this window, users have the opportunity to download and 
apply a diverse array of animations to elevate the visual appeal of the text. After the completion of 
your editing journey, click the "Apply" button to save and add these enhancements to the timeline. In 

there, you are free to apply additional effects or refinements as desired. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

Method 2: Via Custom Toolbar 
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Within the Filmora interface, navigate to the "Title" tab in the custom toolbar and choose any 
desired title. Then, employ the drag-and-drop technique to position the chosen title onto the 

 

243 of 349



Printed with Pdfcrowd.com  

9. Animation & Keyframe 
 
9.1 Preset Animations 

Adding animating effects to video will bring more fun. In Filmora video editor, there are many preset 
animation effects. Double- click the clip in the timeline, then select the Animation. 

 
Drag the preset animations that you like to the video clip. It’s easy and efficient. 
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01 Apply Animation Templates to Videos on Mac 

02 Remove Preset Animation or Preset Motions 

9.2 Animation for Mac 

This guide shows you how to apply animation to make your videos more unique and customized. 

 
When you need animation effects to deal with the connection of clips, the insertion of text, or to make 
your videos attractive, you can apply animation or motion templates. 
 
 

 

 
Apply Animation Templates to Videos on Mac 

You can refer to the following procedure to apply preset animations or preset motions to your video. 

Step 1: Import your video clip 

Launch Filmora on your computer. Then, import the clip as prompted or drag the video from your 
files directly to the timeline. 

Step 2: Launch Animation 

Click the clip in the timeline. Drag the progress bar of the video to where you would like to apply the 
animation feature. In the property panel on the left side of the interface, click Video > Animation. 
Then, you can choose Preset Animation or Preset Motions in the Drop Down List below. 
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After double-clicking the effect, the player on the right side will show you a short 
display of the effect. You can check whether you like it or decide if you want to change 
to another one if you want to preview others. 

 

 
 Preset Animation: There are nine animation templates built into the system, including Fade 

in, Fade out, Pause, Slide Right, Slide Up, Vortex In, Vortex Out, Zoom In, and Zoom Out. 

 Preset Motions: Filmora provides you with more than 70 motion templates. You can preview 
and find whatever you like. 

 
Note: Put the pointer on the animation you would like to preview and stay for a while. The effect will be 
displayed in the little windows where it is located. 

Step 3: Apply the effect 

Drag or double-click the template to apply. Alternatively, you can right-click the effect and choose 
between Apply and Apply to All. 
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Remove Preset Animation or Preset Motions 

Here are the methods to remove preset animation and preset motions: 

Preset Animation 

If you want to reset the Preset Animation, you need to click the clip in the timeline again to launch 
the animation settings. In the property panel, click Video > Animation > Preset Animation. Then, 
click Reset at the bottom of the section to remove the effect. 

Preset Motions 

 
If you want to remove Preset Motions changes, you also need to return to the property panel first. 

Then, click Video > Animation > Preset Motions. Click Reset at the bottom of the section to clear 
changes. Alternatively, you can double-click the first option, No Animation, to revert to the original 
video. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: 
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Besides videos, Filmora also allows you to apply animation features to the text added. 

You can double-click the text inserted into the video and change the effect in the 
property panel by following the steps above 
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9.3 Add Animation Keyframing for Mac 

This guide introduces the steps of adding keyframes and adjusting their settings in your video. 

You can create a keyframe to specify what values for animation qualities should be on specific frames of 
your video. Filmora allows you to set the keyframe scale (size), position, rotation, opacity, etc. When you 
have edited the start and end keyframes, the animation will be automatically exported. 

The suggestions are on the version of Keyframes for macOS. 
 

 

 
 

Add Keyframes 

Here is how to add keyframes in a clip. Step 1: 

Import the video 

Launch the application first. Then, drag the clip from your computer or the library to the timeline. 

Step 2: Activate the Transform feature 

Click the clip in the timeline, then the property panel will appear on the left side of the interface. Alternatively, 
you can right-click the clip in the timeline and scroll to select Add Animation. 
Then, click the button beside properties like Transform to activate the feature. 
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Step 3: Add keyframes 

Move the progress bar of the video in the PLAYER section to where you want to add a 
keyframe. Then, click the diamond icon in the property panel to set a keyframe in the timeline. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note: There is a diamond icon with a shadow and a plus in the timeline toolbar. It functions as 
an exclusive keyframe icon. Once you click on it, all the Transform parameters will be selected as 
keyframe values. You can first choose where to place the playhead and then click the icon to 
add a keyframe. 

 
 
 
 
 
 
 
 

 

Edit Keyframes 

Here is what you need to note when editing keyframes. Step 1: Edit 

the parameters 
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Delete Keyframes 

To delete one or all keyframes in the clip, here are the various methods. 

On the Property Panel/Menu 

 

 

 

When you have added one keyframe, you need to edit the parameters. Adjust the values of Scale, 
Position, Flip, and Rotate the video in the Transform section. In the following sections, you can 

adjust the Compositing, such as the Blend Mode, Opacity, and Drop Shadow and its related values. 
And there are many other features you can set in a keyframe. 

Step 2: Add more keyframes 

After editing one keyframe, you need to add at least another one to form an animation. Otherwise, 
the keyframe settings would maintain unchanged throughout the whole clip. You can add as many 
keyframes as you like. Then, edit the values of each keyframe. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
Step 3: Save the adjustments 

When you have done, click Ok to save the feature. The system will analyze the changes between every 
two adjacent keyframes and give you the output with automatic and smooth animation. 
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On the Timeline 

Right-click the diamond icon in the timeline, and then choose between Delete Keyframe and 
Clear All Keyframes based on your needs. 
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10. Effects & Transitions 
 
10.1 Types Of Effects 

There are numerous effects in the Filmora video editor that can help you make videos or audios more 
creatively. 

 
Numerous effects in Filmora video editor can help you make videos or audios more creatively. 

 
In the Effects tab, there are many types of effects. AI Portrait, AR Stickers, Boris FX, NewBlue FX, Luts, 
Overlays, Filters, etc. You can also find effects based on scenes, like Gaming, Social Media, Wedding, and so 
on. 
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10.2 Filmora Countdown Effects on Mac 

Filmora’s new version comes with rich countdown effects to help people make their videos impressively on 
Mac. You can follow the steps below to add the effects: 

 
Open Filmora and go to search bar from the editing panel. 

 
Enter “countdown” in the search box and you’ll see a list of countdown templates available. 
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Select one of them and drop it to your video, you can customize and preview the effects simultaneously. 
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Index 

01 Target Users 

02 Methods to Use 

03 Show Properties 

04 Tips to Use More Efficiently 

10.3 Audio Visualizer 

Learn the Audio Visualizer function in this guide to solve your problem of single audio cannot be 
distributed as a video on the video platform. 
 
 

 
 

 

Target users 

The function is for podcast users and Music video lovers. Podcast users can use it to play insights 
and stories and add pictures, text, and vibration waveforms to the speech. Music video lovers can 
make one or more songs into a video and post it on YouTube, FB, Ins, Twitter, and other platforms. 

Methods to Use 

❶ Find the Audio Visualizer from the menu bar Effect, select the audio visualizer particle you like, 
drag it to the timeline and place it on the track above Audio. 
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Show Properties 

❶ Click on the audio visualizer particle on the timeline, right-click and select Edit. Pull the left and 

right scroll bars of Intensity, Opacity, Radius, Position X and Position Y to adjust the corresponding 

values. 

 

You can also select the particle, right-click and select Apply, and then place it on the 
track above Audio. 

❷ Play to view the effect in preview window. 
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Tips to Use More Efficiently 

Audio visualization particles only support dragging to the track and temporarily do not support dragging 

and dropping to other clips to become their Effect properties. 

Audio visualization particles temporarily do not support player visualization editing. 

Audio visualization particles may freeze without pre-rendering, but it does not affect the presentation effect. 

❷ Click RESET in the lower-left corner to restore the default 
settings. 
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Boris FX Effects 

FIlmora supports Continuum, professional-quality effects plugins from award-winning 

 

There are 6 Continuum Units customized for Filmora users, unleashing amazing visual effects 
 

Each Continuum unit contains multiple filters with complementary creative presets designed 
 

You can browse from the unique effects and thousands of presets. 

10.4 Add And Modify Boris FX Effects 
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Add Boris FX Effects 
Drag the clip to the timeline. Then select Effects>Boris FX. There are BCC Art Looks, BCC Image 

Restoration, BCC Lights, BCC Blur, BCC Stylize, BCC Particle, BCC PlusLights. You can choose to learn 
about Boris FX effects by Learn More. 

 

 
New Boris FX effects are updated, including BBS Warp, BBC Optical Diffusion and BBC Grads and Tints 
for you to choose. 

 
You can click “Download” button to get your desired effects or get more information of the effect 
introduction. 

 
Then click Download the Boris FX effect plugin. Since the plugin effect package is about 400M, it 

will take time to download the package. Please wait patiently. 

1 

2 
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Boris FX Effects is paid add-on for Filmora, click Buy Now or Try It before exporting. 

 

 
After finishing the download process, follow the prompts to complete the installation. Then restart 

Filmora. You will find the Boris FX Effects in the Effects tab. 

 
Select and preview the effects that you like to apply. 

 

Modify Boris FX Effects 
Double click on the Boris FX effects to open the effects setting. Then modify the effect and make it 

look good. 

3 

4 

1 
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NewBlue FX Effects 

NewBlue 

Stylizer, NewBlue Elements, NewBlue Filters, NewBlue Essentials, and Titler Pro. 

Each collection contains a set of factory-installed, professionally designed presets. These 
 

10.5 Add And Modify NewBlue FX Effects 
 

 

Add NewBlue FX Effects 
Drag the clip to the timeline. Then select Effects>NewBlueFX. There are NewBlue Stylizer, NewBlue 

Elements, NewBlue Filters, NewBlue Essentials, and Titler Pro. You can choose to learn about NewBlue 
FX effects by Learn More. 

1 
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Then click Download the NewBlue FX effect plugin. Since the plugin effect package is about 800M, 

it will take time to download the package. Please wait patiently. 
 

 
After finishing the download process, follow the prompts to complete the installation. Then restart 

Filmora. You will find the NewBlue FX Effects in the Effects tab. 

 
Click and preview the effects that you like to apply. 

2 

3 

4 
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Notice: NewBlue FX Effects is paid add-on for Filmora, click Buy Now or Try It before exporting. 
 

Modify NewBlue FX Effects 
Double click on the NewBlue FX effects to open the Effects Then adjust the effect and make it look 

nice. 

1 
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10.6 Add And Customize Filters 

Add Filters 
Filmora offers hundreds of filters to help you create amazing videos. Just follow the steps below to figure 
out how to use it. 

 
Click the Effects and choose the Filmstock tab. You can see the Filter&LUT option. Then select the 

filter that you like to apply. 

 
Just drag-and-drop the effect to the timeline or onto the video clip. The filter will be used on the 

whole clip if you drop it onto the video clip. 
 

 

Customize Filters 
 You can also change the duration or opacity of filter effects. 

 
Change the Duration: 

1 

2 

1 
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The default length is five seconds, but you can change its duration by dragging the edge of the effect in 
your timeline. 

 
Change the Alpha Opacity of Filters: 

 
The alpha opacity (transparency) property has a value of 0-100. The lower the number is, the more 
transparent the filter is. You can double-click on the filter in the timeline to customize its opacity. Then in 
the Preview Window to view the effect. 
 

 
 

 
 
 

2 
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10.7 Add And Customize Overlays 

Add Overlays 
There are hundreds of overlays to help you create awesome videos. Just follow the steps below to learn 
how to use it. 

 
Click the Effects and choose the Filmstock tab. You can see the Overlays folder. Then select the 

overlay that you like. 

 
Drag-and-drop the overlay to the timeline. 

 

 

Customize Overlays 
You can change the duration or opacity of the Overlay effects. 

 
Change the Duration: 

1 

2 

1 
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The default length is five seconds, but you can change its duration by dragging the edge of the overlay 
effect in your timeline. 

 
Change the Alpha Opacity of Overlays: 

 
The alpha opacity (transparency) property has a value of 0-100. The lower the number is, the more 
transparent the overlay is. You can double-click on the overlay in the timeline to customize its opacity. 
 

 
 

 
 

 
 

2 
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Index 

01 Overview for Filmstock 

02 Key Features of Filmstock 

03 How to Use Filmstock? 

10.8 Filmstock Assets 
 

 
 
 

 

 

Key Features of Filmstock 

Over hundreds of effect packs for video creators and updates every month. High-

quality videos and images from Filmstock to enrich your video editing. 

Thousands of music and audio effects for transitions, gaming, intro, social media, movie, birthday, or 
blockbuster. 

Overview for Filmstock 

Filmstock is a website that offers assets designed for Filmora, including video effects, elements, transitions, 
titles, footages, music, sound effects, and images. 

Visit Filmstock website for more information. 

How to Use Filmstock? 

There are 2 methods to help you better use Filmstock. 

Method 1: Download and Use Filmstock Resources from Filmora 

270 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf
https://filmstock.wondershare.com/


Printed with Pdfcrowd.com  

 

Some resources of Filmstock are paid assets for Filmora, you can click Buy 
Now or Try It before exporting. 

Open Filmora, choose Filmstock tab under Titles, Effects, Transitions, Audio, or Elements. If 
you want to add audio to your video, you can search from the Filmstock resources. Just open 

the Filmora application, go to “Audio” from the head and scroll down to “Filmstock” to select 
your desired audio clip. 

Click and download the assets that you prefer. 

Drag the assets to the timeline to try it. 

 

 
 
 
 
 
 
 

 
Method 2: Download Filmstock Resources from Filmstock Official Website and Use in Filmora 

Login Filmstock with the same account of Filmora. 

Choose and download the effect packs on Filmstock website. 
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The Filmora effect packs of Filmstock can’t be used if you don’t download Filmora. 

 

 
Find the downloaded Filmstock effect packs under the folder Resource pack in Filmora’s 
Titles, Transitions, Effects, or Elements. 

 

 
Drag these downloaded Filmstock resources to the timeline. 
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10.9 Audio Driven Effects for Mac 

Filmora provides users with the ability to enhance their videos with music effects. Within its Effects 
library, you will discover a variety of audio-driven effects tailored to assist in different contexts. In this 
gude, we will walk you through the process of accessing and applying audio-responsive effects: 

Access and Employ Audio-Responsive Effects 

This section explains how to find, access, and apply audio driven effects within Filmora: 

Step 1: Launch Filmora and Select Open Project 

 

Step 2: Access Audio Driven Effects 
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Next, head over to the "Effects" tab and expand the "Audio Effects" category from the left side panel. 
You will find a collection of pre-assembled effects within the "Audio Driven Effects" category. 
 

 
Step 3: Add an Effect from the Collection 

Upon selecting your desired effect, use the drag and drop method to place these desired audio 
effects onto the timeline track above your video, and press the "Play" button in the preview screen 
to see. 
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10.10 Types of Transitions 
A transition is an effect added between pieces of media to create an animated link between them. 

Transitions can help your movie switch smoothly from one scene to the next. 

 
Filmora provides a list of transitions that you can apply to a sequence. A transition can be a subtle 
crossfade or a stylized effect. You can find them under Transitions tab. 
 

 
Filmora offers different types of video transitions to help you create smoother videos without noticeable 
cuts and breaks. 

 
Some of the most interesting video transitions available in Filmora are: 
 
• Ripple & Dissolve  
• Speed Blur 
• Warp 3D 
• Slideshow  
• Gaming 
• Travel   
• Stylize 
• Plain shapes 
• Wedding & Love   
• Linear 

Each of the above video transition categories includes multiple transition templates. 

 
For instance, the “Ripple & Dissolve” category has 30+ transition templates. Similarly, the “Wedding & 
Love” category has 19 templates. 

 
And as you roam around the transitions section, you will find a lot more suitable video transitions that 

would fit your needs. 
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10.11 Add Transition Effects 
Adding transitions to your video helps to improve its flow. You can apply transitions to single clips or in 

between all of the clips on the timeline in Filmora for Mac. 

 
Click into the Transitionstab to see the available transitions. Double-click on transitions you'd like to 
preview. 

 
Once you find a transition you want to use in your project, drag and drop it to the desired location on 

the timeline. 
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 Instead of dragging and dropping a transition you can also place the playhead at the exact spot on 

the timeline where you want to add a transition, right-click on a transition you want to add, and 
select Apply. 

 You can also use the Apply to all option if you would like to add the same transition to all video clips 
in your project. To add a random transition to all video clips, choose Random to All. 

 To delete a transition, highlight it and click the Delete button in the toolbar above Timeline, or press 
Delete key on the keyboard. 

 If you especially love a transition, you can add it to Favorite by right clicking transition in the list and 

selecting "Add to Favorites" from the menu. 

 
Keep in mind that if you are applying a transition, you need to make sure that you've placed a video clip 

on the timeline. 

 
You can add a transition to the start (prefix transition) or the end (postfix transition) of any video or image 
on the timeline, or add transitions between clips. 
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10.12 Modify Transitions 
Filmora offers many types of transitions and the ability to customise the properties of the transitions. To 

do that, you can right-click on the transition on the timeline, and a small menu will pop up. 

 

 

 
You can right-click on the transition you've added and select Duration from the menu. Change the 
duration in the pop-up Duration Settings window and Click OK to apply the change. 

 
Alternatively, once you've added a transition to the timeline, you can alter its duration by dragging one 
of its edges in the timeline. 
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The default duration of all Transitions is 2 seconds. Select Preferences under the Wondershare Filmora 
menu to change the default duration and switch to the Editing Tab. Find the “Transition Duration” and 
enter the new duration. This will become the new default duration for all transitions in your project. 
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To apply the same transition through your entire project: 

Right-click on the transition you want to use and select APPLY TO ALL. But note that 
this transition can only be applied for the duration. 

 

 
You can also change more options of the transition by selecting Show properties. You can also select a 
Transition Mode in this menu to determine how your transition will sit between the clips. You can choose 
from Overlap, Prefix, and Postfix. 

 

 

 

 
Click the OK button to confirm your adjustments 
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11. Stickers  
 
11.2 Types of Stickers 
Stickers are motion graphics you can use to decorate your videos. You can add motion graphics to your 
videos to make them look more attractive. To do that, you can click the “Stickers” tab to check out the 
entire list of templates. 
 

 
Some of the most popular “Stickers” templates are categorized under: 

 
 Hand Drawn – 21 templates 

 Badges – 12 templates 

 Tutorial – 64 templates 

 Web – 64 templates 

 Pets – 11 templates 

 Shapes – 6 templates 

 Emoji – 9 templates 

And there is more to unearth. 
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11.2 Add and Customize Stickers 
The Stickers is one of main important categories for you to create awesome videos. You can find this tab 
on top of the editing window. The Stickers tab contains a large number of stickers which you can easily 

overlay on your video by drag and drop action. 

 
In this guide, let's learn how to add stickers to your videos in Fillmore and how to control that sticker. 

 
There is built-in sticker category which is right inside the installation package of the program and 
downloaded stickers which you can get from Filmstock - An online footage library of Wondershare. 

To add a sticker to your project 

In order to overlay a sticker on your video, you can click this little plus icon at the center of the 
thumbnail. You can also double click on the thumbnail to preview it before adding to your project. 
 

 

 

To favorite a sticker 
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If you have some common use stickers, you can add your stickers to this favorite folder by hitting the star 
icon on the thumbnail. 
 

 

 

To customize a sticker 

You can double click on the element box to have more control of the sticker. Filmora considers a sticker 
similar to a video clip, meaning that you can control it the same way you can do with a video clip on the 
timeline. 

 
You can transform your clip, select a blending mode and adjust the opacity of the clip or apply green 
screen effect. 
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Trim Video on Mac: 2 Hassle-Free Solutions 

Do you want to trim video on Mac, but can't find any feasible solution? Read this post and learn how to 
trim any video on your Mac with 2 smart apps. 

Fail to import AVCHD file. 

Guide user how to import AVCHD files. 

Why can’t I apply the transition to the video? 

Guide user to apply the transition to the files on the 1st track. 
 

 
If you want there are many creative ways you can do with overlay elements in Filmora, the basic steps 

are adding a sticker on top of the video track, adjust its size and position on preview window change, 
the color of the element and add a motion for it: it's all up to your creativity, to decide when and how to 
use it. 

To remove an element from your project 

There are two ways to remove a sticker from your video: 

 
 Select the sticker that you want to remove and hit Delete on your keyboard. 

 Right click on the sticker in the timeline and select Delete from the menu. 
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12. Exporting & Cloud Backup  
 
12.1 Workflow and Overview for Exporting 

The Workflow of Exporting 

You will export the video when you finish editing. Here is the workflow of exporting: 

 
First, find the “Export” button on Filmora and click it. 

 

 
You will see Seven options for exporting. They are Select Clip Range, Create Video, Export to Device, 
Upload to Youtube, Upload to Vimeo, Burn DVD, and Export selected video clips.. 
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If you are unsure which to choose, just select the first one, “Create video”. You will see all the options 
for exporting. 

Choose the one way you want to export and click the “Export” button. You will see your video in the 
specified position. 
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The Overview of Exporting 

Filmora provides Five ways to export your videos. Here is the introduction for the five ways. 

 
 Export to Local 

 
You can export your project file and video to the local computer. It supports to export as MP4, WMV, AVY, 
MOV, F4V, MKV, TS, 3GP, MPEG-2, WEBM, GIF, and MP3. 

 
 Export to Device 

 
You can export your video to the device you want, including iPhone, iPad, Apple TV, Apple TV 4K, iPod, 
Samsung Galaxy, Smart Phone, Android Generic, Xbox One, PlayStation, PSP, and Smart TV. 

 
 Upload to YouTube 

 
Filmora supports exporting your video to Youtube directly. All you need to do is logging your Youtube 
account and export. 

 
 Upload to Vimeo 

 
Filmora supports exporting your video to Vimeo directly. All you need to do is logging your Vimeo 
account and export. 

 
 Burn DVD 

 
You can burn your video from a DVD. Choose the DVD tab and enter the required settings, such as the 
aspect ratio and disc type. 
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12.2 Export Video to Local Computer 
Here is how to export and share your finished video in various type of Formats: 

 
To export your video to your computer, click the “Export” button and choose the “Local” tab. Then, select 
the format you want to export in. Currently, Filmora supports the following formats: WAV, MP4, AVI, MOV, 
F4V, MKV, TS, MPEG-2, WebM, GIF, AV1 MP4, MP3, GoPro CineFrom and more as shown below. 
 

 
After selecting the output format, you can rename the video and change the location on your computer 
where you want to save it. You can also check the output resolution, frame rate, size, and duration before 
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you export. To change your export settings (i.e. resolution, bit rate, and frame rate) click the “SETTINGS” 
button. 

 
In the Settings window, there are three quality levels: Lower, Recommend and Higher. The only difference 
between them is the Bit Rate. You can easily adjust this or other parameters, such as Resolution, and 
Frame Rate in this window. 

 

 
 
It is best to export your video with the same settings as your original video. 

 
When you’re finished adjusting your export settings, press “Apply” to save them. Then, after you have 
closed the Settings window, press the “Export” button in the Export window. 

 
 

 

Note: The size of the video depends on the length of the project and the bit rate. If the file size looks too 
big, you can try changing the bit rate in the Settings window to make it smaller. 
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12.3 Export Video to Different Device 
Here is how to export and share your finished videos: 

 
In the Device tab under Format, you can choose to output your video according to the ideal settings for 
different types of devices, such as iPhones, iPads, Apple TVs, Smart Phone, Galaxy S, Smart TV, 
PlayStation, and more. You can also make manual adjustments to your settings by clicking the Settings 
button. Click on “Export” button when you’re finished. 
 

 
Note: Exporting in this way won't automatically transfer your videos to your devices. While, your videos will 
still be stored on your computer’s local hard drive. 

290 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


Printed with Pdfcrowd.com  

12.4 Export Video to Vimeo 
Here is how to export and share your finished video to the Vimeo: 
 

 
To upload a finished video directly to Vimeo, click on “Export” and then select Vimeo. Input the title, 

description, and tags for the video and choose whether to upload the video as public, unlisted, or private. 
You will also need to sign in to your Vimeo account. 
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12.5 Upload Video to YouTube 
Here is how to export and share your finished video to your YouTube channel: 

 
To upload a finished video directly to YouTube, click “Export” and select “YouTube”. Input the title, 
description, and tags for the video and choose whether to upload the video as public, unlisted, or 
private. You will also need to sign in to your YouTube account. 
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12.6 Burn to DVD 
Here is how to export and convert your video into DVD: 
 

 
You can burn your video from a DVD. Choose the “DVD” tab and enter the required settings, such as the 

aspect ratio, TV Standard and disc type. 
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A Media Library is provided for you to organize your media clips to easily and quickly catch 
assets for your projects. 

How to Import Media Files 

There are 4 ways to import media files to Filmora. 

 

12.7 Importing 

Wondershare Filmora for Mac lets you import video shot by any digital camera, camcorders, mobile 
devices, etc., in all significant standard and HD video formats. You can also record your video from your 
webcam. 
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Way 2. Drag and drop to the Media Library directly. 

Way 3. Go File > Import Media, and choose one of the below sources: 

Import Media Files: Import a single media file. 

Import Media Folder: Import a media folder containing more than one media file. 

Import from External Device: Import media files from an external device like a USB drive, 
hard drive, and more. 

Import with Auto Beat Sync: Import media files with Auto Highlight, Auto Beat Sync, 

and Video Effect features. 

Import with Instant Cutter Tool: Import trimmed/cut video from Instant Cutter Tools. 

Import from other Apps: Import media files from Google Drive, One Drive, and Dropbox. 
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Way 4. Click the Import on the top bar to import the media file. 
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12.8 What is Wondershare Drive 
Wondershare Drive is a cloud storage for work and content creators. You can safely store and share 
photos, videos, files and other contents without the device limitation. 

 
The most important is you can upload the project in Filmora to the Wondershare Drive to enable you to 
edit videos anywhere. 

 
You can manage files in Wondershare Drive in Filmora or by visiting https://drive-web.wondershare.com/. 
 

 
In this page, you can also upload files. Besides, you can make basic management inside the drive including 
moving, renaming, deleting, downloading files. Even you can star the important files. 
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12.9 Get 1GB Cloud Storage for Free 
2 Steps to get 1GB cloud storage freely. 

 
 Download and open Filmora. 

  Click “Cloud Project” and then log into your account to activate the cloud. 
 

 
Now, you can get 1GB for free and start to use the drive. 

 
Note: You can get 1 GB for free after activating Filmora account. 
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12.10 Use Wondershare Drive 
In Filmora, you can get 1GB cloud storage for free to upload, save, download and share your videos and 
project files. 

 
You can use Wondershare Drive in Filmora software or through a web browser. 

Using Wondershare Drive in Filmora 

It's easy to save and upload project files to Wondershare Drive. When you launch Filmora, choose Recent 

Project and you can see all local projects, you can click the cloud icon to upload and save local project. 
 

 

 

Using Wondershare Drive through a web browser 

You can also use Wondershare Drive by visiting https://drive-web.wondershare.com/. To save your video 
and project files, click Upload button and choose the files in the local computer. 
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12.11 Find Files in Wondershare Drive 
There are 2 methods to find your cloud files. 

 
  Find cloud files in the Cloud Project. 

 

 
 Find cloud files in Media>Project Template>Custom 

 
Note: You can find the custom files you want only the files are saved as template. 

301 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


 

12.12 Manage Wondershare Drive 
Click “Cloud Project”, you can check your cloud project files, which includes sharing, deleting and 
reveling in explorer. 
 

 
Or you can just click the “cloud” icon on the top to manage your cloud files. Besides, you can see the 
expired date and the storage of Wondershare Drive. 
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12.13 Share files with Wondershare Drive 
With Wondershare Drive, you can easily share you videos and project files to others. People can see your 
sharing videos and edit with your project files. 

 
Note: The sharing project files are only supported to edit in Filmora. There 

are 2 ways for you to share your video and project files in Filmora. 

Switch to “Recent Project” tab and choose Cloud Project, choose the project you want to share, and 
then click the share icon. 

 

 
Or you can just click “cloud” icon on the top and click the share icon. 
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You can share your files with or without passwords. The validity period is about 1,7 and 30 days. 

 
If share with passwords, you can set the passwords you want. Filmora supports 4 letters or numbers 

as passwords. 

If share without passwords, all you need to do is choose the validity period. 
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After setting the sharing options, you can create link for sharing. Click 

“Copy” to quickly copy the link and share it with others! 

 

 
People can open the link and see what you share. 
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Index 

01 How Does Cloud Backup Help with Sharing/Cooperating on Video Editing? 

02 How to Use Cloud Backup? 

12.14 Best Practices: Cloud Backup 

Cloud backup service aims to make video-editing cooperation and sharing easier for video creators. 
 

 

 
How Does Cloud Backup Help with Sharing? 

How to Use Cloud Backup? 

 

Upload Project 

Open Create Project > Local Projects and click on the Upload icon on the project you would like to 

backup to Inclowdz Drive. Once completed, you can find the video under the Cloud Project tab. 

 
❶ It could be troublesome to carry external storage when you need to edit your video projects on 
a new computer or share them with your colleagues. 

❷ With cloud backup, you can upload the file to Wondershare Drive and download it anywhere, 
anytime to continue editing or share the project file with your friends/colleagues for them to add 
their creative thoughts. 
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Open Project 

Click the Folder icon to open the projects with Filmora. 

Share Project 

Under the Cloud Project tab, click the Share icon to share the download link with anyone you want. 

Delete Project 

If you wish to delete any projects, click on the dustbin icon. 
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Paid users will automatically be granted access to 1GB cloud storage. 
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Accessing the Export Windows 

 

Step 1: Initiate the Export Process 

 

Step 2: Customize the Export Parameters 

Following the previous action, an Export window will feature on the screen. From there, users 
 

12.15 Export Settings for Mac 

Filmora's diverse video editing capabilities elevate the visual appeal of your content, but the wonders 
continue beyond there. Its advancements and upgrades provide users with custom options within its 
Export window. If you want to ensure a seamless export, read this guide below: 
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parameters. Once you have adjusted these settings, press the "Export" button to download 
these files on your device. 
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How to Export Selective Clips in Filmora 

For those seeking to learn the technique of exporting selected clips within Filmora, the following 
 

Step 1: Activate the Export Functionality 

navigate towards 
the "Export" button. Afterward, expand the navigation arrow on this button 

 

Step 2: Personalize the Export Settings 

12.16 Export Selected Clip for Mac 

In video editing, editors often need to export specific clips from a timeline and a function, and Filmora 
offers this option in its editing interface. This feature optimizes the editing process, which allows users to 
export selective segments with convenience. This comprehensive guide contains the essential 
information for exporting chosen clips within Filmora: 
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As the new window appears, adjust for file name, storage location, frame rate, resolution, and 
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Index 

01 Defining the Clip Range 

02 Exporting the Defined Clip Range 

12.17 Export Clip Range for Mac 

Filmora enables users to define a specific range within an existing video clip and export it. This feature not 
only ensures a streamlined workflow but also eliminates the need for trimming before exporting. To delve 
into the efficient and time-saving features of Filmora, pay attention to the detailed guide below: 
 
 

 
 

Defining the Clip Range 

There are two methods that users can employ according to their preference for defining a clip's range 
before exporting: 

Method 1: Via Preview Window 

Step 1: New Project Initiation and Clip Import 

Following the installation and launching of Filmora, locate and select the "Open Project" button on the 
main menu's right side. Afterward, select a media file for import from your device, and it will be added 
to the timeline. 
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Step 2: Selection of the Clip's Starting Point 

Once your chosen clip is in Filmora's timeline, direct your attention towards the "Preview" section. 
Click the "{" icon to invoke a slider that enables precise adjustment of the starting point of the clip. 
 

 
Step 3: Designate the Clip's Ending Point 

For setting the end point of this clip range selection, repeat the process; however, this time, engage 
the "}" icon. 

Method 2: Via Keyboard Shortcuts 
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Exporting the Defined Clip Range 

Once the clip range has been set, proceed to export it by following the step-by-step approach mentioned 

below: 

Leveraging the Export Functionality 

After establishing the clip range using the previous method, navigate to the "Export" button and click 
it. A "Select Clip Range" window will emerge where you can adjust the settings, including the folder 
location for your clip, its name, and additional parameters. Upon setting all these parameters, finalize the 
process by choosing the "Export" button. 
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Index 

01 Usage Scenario 

02 Launch Workspace on Mac 

03 Workspace Interface 

13. Collaboration 
 
Filmora Workspace for Mac 

This guide teaches you how to co-create your video with your friends, clients, or colleagues in Filmora 

workspace. 

 
Filmora workspace is an online platform that allows you to receive comments from others after sending them 
a link with some permissions. Also, you can leave a comment on other people's videos. 
 
 

 
Usage Scenario 

As a video designer, you might sometimes feel confused about how to improve some parts of your video. 
Now, a solution comes as Filmora workspace offers you a co-creation platform. Here you can share the link 
created automatically with some people, inviting them to give some feedback and modify the clip 
accordingly. 

Launch Workspace on Mac 

The content below introduces how to launch the workspace of Filmora in macOS. 

 
Step 1: Log in or create your account 

 
After launching the application, you need to log in first when you want to use this feature for the first time. If 
you don't have an account, use your email address to create one. 

 
Step 2: Activate Filmora workspace 

 
In the top right corner of the interface, find the Transfer Center icon, as marked in the below image, and click 
it. Then, as prompted, you can find Filmora.io here. Click Go experience it to have a try. 
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Workspace Interface 

The following contents are about the features you can see in the workspace interface. 

 
Media Files 

 
Media Files is the place where your videos will be displayed. You can drag or drop a file from your computer 
to this section. 
 

 
After that, right-click the video you need, then you are allowed to View, Share, Rename, Download, or see 
its Details. 
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Notes: 

 
Then, you can share it with friends or comment on others' clips. 

 
 Share 

 
Click Share to create a link automatically that you can send to others. You can choose from sharing 
Without Password and With Password. 

 
If you need a password, the system will give you a secure and uneditable Access code. 

Besides that, you can set the expiration of the link, including 1 day, 7 days, 30 days, or Never. 

Plus, you can adjust the Permission of the video, including Download and Comment. 
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 View 

 
This feature is where to comment on the video. Comments can be made based on the exact time of the video 
or the Overall video. Not only can you send your own opinions, but you can also view your friends' feedback 
from whom you have sent the link. 

 

 
Finished Videos 

 
This section is to show your exported videos uploaded in Filmora. 

 
Project Files 

 
Here is to show the project files that you've uploaded to Filmora. 

 
Shared Files 
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All the recordings of your shared videos will appear here. You can view these videos, copy the link again, or 

change the settings of the link if you need. 

 
Recycle Bin 

 
If you've carelessly deleted a video, you can find and restore it in the Recycle Bin. 
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Key Functional Features 

HDR displays a more comprehensive range of brightness from the darkest to the brightest. 

It accommodates more brightness, shadow detail, and saturation for a more natural and 
 

You can switch to HDR export when the current device meets the GPU acceleration  

Color Space 

Project Settings 

 

 
Index 

01 Key Functional Features 

02 Color Space 

03 Functional Limitations and Reminders 

14. Improving Performance & Troubleshooting 
 
14.1 HDR 

The HDR (Highly Dynamic Range) function mainly targets semi-professionals or professionals whose 
devices support HDR. HDR materials shot by users or obtained from other channels can be edited, 
previewed, and exported in Filmora. 
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Export Color Space 

On the Export interface, click SETTINGS. When the Export Color Space is always on, the 
current device has enabled GPU acceleration (GPU acceleration in the preferences). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Functional Limitations and Reminders 

Timeline Rendering: After rendering in HDR state, the player preview video clarity will be reduced. 
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GPU Support: Enable GPU acceleration for preview, rendering, and export. Filmora has a corresponding pop-
up reminder on it. 

Export Speed: The export speed of HDR video is about 4 times slower than that of SDR video. 

Device Support: If your device does not support or does not turn on HDR, Filmora will prompt a pop-up 
window and remind you that the preview function of HDR is limited to the case that the device supports 

and HDR is on. 

323 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf


 

 
Index 

01 Known Issues 

02 Fixed Issues 

 

Last update on Jun 21,2022 

These are the issues you might encounter when using Filmora.Z 

 

Last update on Jun 21,2022 

These are the issues we fixed in recent Filmora release. 

14.2 Known Issues & Fixed Bugs 

Find known issues and fixed bugs in the latest release of Filmora. 
 

 

 
Known Issues 
 

 
  Unable to export videos directly to YouTube 

 
We are sorry to say that you may fail to export video from Filmora to YouTube directly, but you can still 
login YouTube account. The increasing amount of video exporting has reached the limit of our daily 
YouTube API quota. We are currently trying to apply more quotas to fix the issue. During this period, you 
can export the video to your computer and then upload to YouTube. 

Fixed Issues 
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Fixed Issues in Filmora 11.5.0 

 Bugs related to automatic upgrade 

 "Cannot save text resources" issue 

 Resource crash 

 Cannot use TTS 

 

Fixed Issues in Filmora 11.4.5 

 Crash of beauty effects 

 Player crash while using vertical screen 

 Audio filter icon still shows after being deleted 

 Icon too big in text editing panel 

  Cannot export in some scenarios while using auto ripple on 

 

Fixed Issues in Filmora 11.4.0 

 Cannot run on Windows 11 

 Issue with feedback 

 Crash when using “redo” shortcut in editing WordArt 

 Cannot play when double-clicking audio visualization 

 

Fixed Issues in Filmora 11.3.5 

 The exchanges problem of STT/TSS member benefits 

 Crash after setting the width to 0 in applying mask 

 Crash in click download AR sticker assets repeatedly 

 Similar search no result and no text reminder 

 Cannot save resource assets 

 

Fixed Issues in Filmora 11.3.0 

Motion tracking failed to work after adjusting the tracking frame 

Fade effects in SRT advanced text editing not working 

Editing box lost while adjusting mosaic motion tracking 

Program irresponsible in creating a proxy after importing too many files 

 

Fixed Issues in Filmora 11.0.8 

Translation errors in multi-language versions 

Not showing full icon after applying key framing 

After enabling shortcut from timeline, the properties panel is not synchronized 
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14.3 Group Clips 
In an instance, we want to aggregate a few clips on the timeline to a single place on the video clip. For that, 
we need to group those clips and later on perform certain editing depending upon the requirements. 

 
In this guide, you are going to learn about grouping, ungrouping, and making a cut in a group on your 

timeline. 

How to Group Clips 

Grouping a particular section on the timeline is a fine art but it would take a lot of clicks if you are not 
using the productive method. The art of aggregating a few clips into one frame is made easy and 
wonderful with Filmora video editor. Let’s learn to do it in just 1-2 clicks with the help of this wonderful 
guide. 

 
Drag your cursor and select the clips that you want to move on the timeline. This method would save 
your time of selecting and putting each clip manually. Alternatively, you can press CTRL key and click 
all the clips need to be grouped. 

 
If you want them to be in a group you need to drag over the group of clips, right-click on the timeline, 
and select KeepGroup from the options. 
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 This way you will be able to group and drag several clips without manually picking up each one of 

them to a certain section on the timeline. 

 

How to ungroup clips with Filmora 

If you want to ungroup the clips you need to right-click on the grouped clips and select Ungroup. 
 

 
Your clips are ungrouped now and you can drag them one by one to any section on the dashboard. 
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How to Make a Cut in a Group 

In this part, you will learn to make a cut in the group with simple clicks. 

 
Click on the scissor icon as shown in the image and it will highlight the group that will be cut. 

 
Now a window will come up to ask if you want to ungroup or cut the grouped clips. 

 
You can checkmark or uncheck the box if you want to see this suggestion in the future. 

There are two cases in this section. If you select Ungroup from the options then your clips would 
move isolate. Ungrouping the clips while cutting is not considered as a good practice. 

 
  You should always select the Keep Group option so that your clips stay together even after a cut. 

 

 
Now you have learned how to group, ungroup clips, and also how to make a cut on the group of clips. 
This is very simple and precise where you would find yourself in a position to do it more precisely. 
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14.4 Manage Timeline 
The timeline is where the majority of the video editing process takes place. So, in this tutorial, we are 
going to learn how to add, adjust, lock and hide video and audio tracks in Filmora timeline panel. 

Using the timeline 
The Playhead is an indicator that shows you where on the timeline you are currently located and allows you 
to move through the media files you placed on the timeline. The frame at which the Playhead is 

positioned is going to be displayed in the Preview window. 
 

 

 

Adjust Timeline View 

 
As you hover over the area of the timeline that shows time with your mouse, the pointer is going to 
change into a two-way arrow. Move the mouse either to the left or the to the right while holding the 
left-click to zoom in or to zoom out of the timeline. 
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The Zoom to Fit the Timeline icon is located in the upper right corner of the timeline. Clicking on this icon 
will enable you to see all the media you’ve added to the timeline within a screen. Alternatively, you can use 
the zoom slider if you want to adjust the zoom level manually. 

Managing Tracks 

A track is the part of the timeline where all the media is located. Tracks in Filmora can either hold video or 
audio files, and you should keep in mind that audio and video clips can never be on the same track. 

Add One Track Each Time 
In order to create and add a new track you just have to drag and drop audio or video file to a preferred 
location. Filmora will automatically create a new track for the elements dragged to timeline. 
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Add multiple tracks at the same time 
Click the Manage Tracks icon located in the upper left corner of the panel and a drop-down menu that lets 
you add new audio and video tracks or delete a track is going to appear on the screen. 

 
 

 
 
 
Click the Open Track Manager option and then you can add up to 99 video and audio tracks to a 
project from the Track Manager window. Moreover, the Placement drop-down menu lets you choose 
how the tracks are arranged. 
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If you right-click on the section of the timeline below the Manage Tracks icon where the information 
about tracks is displayed you can access each of these options from the right-click drop-down menu. 

 
Under the Manage Tracks menu, you can increase or decrease the size of the tracks from the Adjust 
Track Height submenu. 

Hide & Lock Timeline 

You can click on the Toggle Track Output icon that looks like an eye on a particular track if you want 
the media invisible. The Toggle Track Output option is depicted as the sound icon on audio tracks and it 

enables you to mute an entire track. 
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The lock icon lets you lock all media on a track. Once you look a track, you will not be able to edit, move 
or change the media files you added to that track. 

Organizing the timeline with markers 

The Add Marker icon is located in the upper right corner of the timeline and after you click on it, a new 
marker will be added to the same location on the timeline where you placed the playhead. 
 

 
Double-click on the marker you created if you want to gain access to the Marker Editor window where 
you can change the name or the color of the marker or add a comment. 
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If you would like to add a marker to a video clip you just have to make sure that the clip is selected and 
click on the Add Marker icon. Creating notes can be useful when working on large projects because you 
can use them to line up different types of media assets. 
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14.5 Change Playback Quality 
For smooth playback during editing, you can change the playback quality. Look at the area under the 

playback window; you’d see a small drop-down button that allows you to change the playback quality. 
 

 
You can transition to 1/2, 1/4, 1/8, 1/16, or else stick to full quality. Let me explain if this seems 
confusing; 1/2 means half the playback quality and 1/4 means one-fourth of the original playback quality. 

In my experience, changing full playback quality to half the playback quality does the job. 
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14.6 Mark Clip 
Markers can be used either while you are recording or during the post-production, to help you mark the 
places in the footage where you've made a mistake, where the new take starts or to indicate a spot on 

the timeline where you would like to place a particular video clip. In this article, we are going to show 
you how to utilize markers while you're editing videos with Filmora. 

 
Watching the footage you've captured over and over can be a tiresome process that consumes both time 
and energy, so in order to increase your efficiency during the process of capturing and editing videos, 
you can simply add markers both to the timeline and the files on the timeline. 
 

 
You can click the marker icon to mark any point in time. 

 
Distinctions Between the Two Types of Markers 

 
The media markers are the markers you can add directly to the video file. You won't be able to see these 
markers until the video clip is imported into the software's video editor and placed on the timeline. 

 
You can use them to mark a place you're not too happy with, or to highlight the part of the video clip that 
you intend on featuring in the final cut of the video you've created with video editing software. 

 
By doing so you'll save time on going through all the material just to find a few seconds of footage that 
fit perfectly to your video. 
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The timeline markers, on the other hand, can only be added to a project during the post-production 
period. You can utilize them to highlight the parts of the video clip you want to remove from the final 
version of your video or to mark the spots on the timeline where you'd like to switch from one take to 
another. 

 
This type of marker is immensely useful if you want to organize the timeline in your project better and to 

know exactly where every clip you want to use in your video is located at all times. 

 
Besides being a highly efficient tool for organizing vast amounts of footage, timeline markers can also 
help you denote the beats in the audio file and then sync the video clip perfectly to the beat of the tune 
you're using as a soundtrack to your video. 
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14.7 Project Settings 
When you click the New Project button on the welcome screen, you will be taken to this screen, which is 
Filmora’s default interface. 

 
If you forgot to set the aspect ratio from the welcome screen, or if you wanted to use a different aspect than 
the defaults. You can do so by choosing "Project Settings" from the File menu. 
 

 
Now, you can pick the correct aspect ratio, resolution, and frame rate from the Project Settings window. To 
use a custom aspect ratio, what you have to do is to change the resolution. 
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For example, if you are making an Instagram video, change the resolution to 1080 by 1350 and Filmora will 
automatically set aspect ratio for you. You can lock the aspect ratio by clicking on this lock icon here. 

 
The video aspect ratio is the video width in proportion to the height. This ratio describes how wide your video 

is. 

 

For example, a video with a 16:9 aspect ratio would not be 16 px wide and 9 px tall. You wouldn’t be able to 
see a video that small. One resolution that has an aspect ratio of 16:9 is 1920 px by 1080 px. 

 
The resolution of our project is measured in how many pixels wide and how many pixels tall the video is. By 

default, Filmora projects will start with the resolution of 1920 pixels wide by 1080 pixels high. Since this is 
the standard scale of full HD video, we can freely change the resolution by modifying the number on each 
box. 

 
The frame rate is the number of frames a video will show within a second. Many digital video cameras 
shoot at 23.976 and 29.97 frames per second. These are the standards in countries that use the NTSC 
system. 

 
The 25 and 50 frames/second are used by the cameras in countries that use the PAL system. Most movies 
work in 24 frames/sec. 

 
Some TV shows and home cameras work in 30 frames per second which reflects a realistic motion similar to 
what we are used to seeing in real life. 

 
Anything higher than 30 frames per second is mainly used to create slow motion. Though some people 
primarily gamers tend to work with higher frame rates like 60 frames per second. 

 
If you are making videos to post on social media like YouTube, most frame rates should work fine. But it is 
ideal to match the settings of whatever footage your camera took. By default, Filmora will ask you if you 
want to match the settings of your footage when you drag the first clip into the editor from the media 
panel. 
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14.8 Working with Proxy 
Once all the video clips you’d like to use in your next video are transferred from the camera to a computer 
and organized properly, you can start thinking about the most efficient way of piecing them together. 

 
That’s where the creation of proxy files comes in, as you don’t have to work with the original size RAW 
files. Instead, you can create proxies that are significantly smaller than the video files your camera has 

captured and still export the video in the 4K or UHD resolution. 

 
This is a simple and yet very effective video editing technique that makes the video editing process 
much smoother since it will shorten the amount of time your computer needs to render previews or 
perform any other video editing task. 

What is Proxy Video Editing and How Does a Proxy Work? 

Proxy video editing is a great option if the computer you’re using for editing has a modest amount of RAM 
or if its processor is not powerful enough to support the demanding tasks of applying complex visual 
effects. 

 
Even though proxy files can shorten the amount of time you need to spend in the editing room, this 

video editing technique is only useful in a particular context. So what are the benefits of proxy video 
editing, exactly? 

 
Check our guide about How to build a computer for 4K video editing 

When Should You Use Proxy Video Editing? 

Whether or not you can benefit from using proxy files during the video editing process depends on how 
powerful the computer you are using to edit videos is. 

 
If you have a laptop or a desktop computer that meets all of the video editor’s advanced technical 
specifications, then creating proxy files won’t boost the software’s performance significantly. 

 
However, if you are editing on a device that is primarily designed for web browsing or an older model of a 
PC or a Mac computer, then reducing the resolution of the files you use in your projects can save you some 
time or even prevent the software from crashing at a crucial moment. 

340 of 349

https://pdfcrowd.com/html-to-pdf/?ref=pdf
https://filmora.wondershare.com/4k/build-4k-video-editing-pc.html


Printed with Pdfcrowd.com  

 

 
How to Create and Use Proxy in Filmora 

Video content creators who often shoot their videos with action cameras and other devices that can record 

video in 4K resolution can easily create proxy files in Filmora. 

 
So, once you’ve installed Filmora on your Mac or PC computer, you should just double click on its 
desktop icon and after the app’s welcome window pops up on the screen, you should just click on the 
New Project option. 

 
Head over to the File menu, when the new project opens and locate the Preferences option. 
Alternatively, you can use the CTRL+SHIFT+, keyboard shortcut to bring up the Preferences 
window and then click on the Performance tab. 
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Make sure that the Enable GPU Acceleration option is activated by clicking on the appropriate checkbox 
and proceed to select your computer’s graphics card from the drop-down menu. Click on the checkbox 
that is located next to the Automatically create proxies when media resolution is higher than: option in 
the Proxy menu, and then pick either 1280x720p or 1920x1080p resolution. You can also choose a folder 
on your computer’s hard drive where all proxy media files are going to be saved by clicking on the Browse 
button in the Proxy Location submenu. 

 
In case you want to delete all proxy files you created after you’ve completed a project, you can enable 
the Automatically delete proxies when a project is closed option and then click on the OK button to 
confirm the changes. 

 

Go to the Media Panel to start importing media files you’d like to use in your project and Filmora will 
automatically create proxies for each file that has a resolution that is higher than the resolution you’ve   
specified earlier. 

 
Keep in mind that the amount of time Filmora is going to need to create proxy files depends on the size of 
source files and the number of files you are transcoding at the same time. 
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14.9 System Compatibility Detection 
In order for Filmora to run properly it must be installed on a system which meets or exceeds the following 
requirements. 

Filmora for Mac System Requirements 

 Operating System: macOS V12 (Monterey), macOS v11 (Big Sur), macOS v10.15 (Catalina), macOS 
v10.14 (Mojave). 

If you are using OS X 10.7 to 10.13, click here to get the compatible version » 

 Processor: Intel i5 or better multicore processor, 2 GHz or above 

(Intel 6th Gen or newer CPU recommended for HD and 4K Videos, also compatible with Apple M1 
chip). 

  Memory: 8 GB RAM (16 GB required for HD and 4K videos). 

  Graphics: Intel HD Graphics 5000 or later; NVIDIA GeForce GTX 700 or later; AMD Radeon R5 or later. 

2 GB vRAM (4 GB required for HD and 4K videos). 

 Disk: At least 10 GB free hard-disk space for installation (SSD-Solid State Disk recommended for 
editing HD and 4K videos). 

 Internet: Internet connection is necessary for software registration and access to online services 
like Filmstock. 

 
Tech Specifications of Filmora for Mac(Or for Windows here) 
 

Supported Input Formats 
 

Type Container formats 

Video Formats MPEG-1/2 Video file: (.mpg, .mpeg, .m1v, .m2v) 

MPEG-4 Video file: (.mp4, .m4v, .3gp, .3g2, .3gp2) 

QuickTime Movie File: (.mov encoded with MPEG 4 or MJPEG codec only) 

 

Type Container formats 

 
Camcorder File: (.dv, .mod, .tod, .mts, .m2ts, .m2t) 

Flash Video: (.flv, .f4v) 
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Audio Visual Interleave (.avi) 

Matroska Video File: (.mkv encoded with MPEG 4 or MJPEG codec only) 

HTML5 Video File: (.mp4, .webm,. ogv) 

Non-encrypted DVD Titles: (.vob, .vro) 

Audio Formats .mp3, .m4a, .wav, .wma, .ogg, .flac, .aif, .aiff, .caf, .au 

Photo Formats .jpg, .png, .bmp, .gif, .tif, .tiff 

Supported Output Formats 
 

Type Container formats or Device/SNS profiles 

 

 
Format 

Common 

video/audio 

.mov, .mp4, .m4v, .mkv, .avi, .f4v, .ts, .mpg, .3gp, ProRes, .m4a, 

.mp3, .gif 

4K .mov, .mp4, .m4v, .mkv, 

 
Devices 

iPhone, iPad, Apple TV, Apple TV 4K, iPods, Apple Generic, 
Android Generic, PlayStation, PSP 

Social Network YouTube, Vimeo 

DVD DVD disc, DVD folder, ISO disc image file 

* Some of the above codec formats may need to be supported by system. 
 

Supported Effects & Plug-ins 
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Effects & Plug-ins 

Filmstock Standard 

NewBlue FX (Not available on Mac with M1 chip) 

Boris FX (Not available on macOS v10.14 and Mac with M1 chip) 

AI Portrait 
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14.10 Render Preview Files 
This lesson of our Filmora tutorial is dedicated to the Render Button that will ensure the smooth 
playback of video files and visual effects, you add to the timeline. 

Rendering Previews from Filmora’s Timeline 

The playback of high-resolution video files can lag sometimes if the computer used for editing those files 
doesn’t have enough processing power. Lagging can occur regardless of the video editing software you 
are using, but Filmora offers a quick way to fix this issue. 

 
The rendering process can be described as a process during which a computer processes information 
from a particular data source and creates a preview image that is displayed in the software’s preview 
window. 

 
After you add new media files to the Filmora’s timeline, a red line will appear over the portion of the 
timeline these media files occupy indicating that the footage hasn’t been rendered yet. 
 

 
Your computer will generate rendered versions of the files you placed on the timeline after you click on 
the Render Preview button that is located in the upper left corner of the Filmora’s timeline. 

 
The Render Progress bar will pop up on the screen, informing you about how much time remains until 
the rendering process is completed. 

 
Keep in mind that rendering process can take a while if you are working with a lot of different high- 
resolution files. 
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The rendering process will eliminate the lagging effect that commonly occurs when multiple visual 
effects are applied to the footage. Once the rendering process is completed, the red line displayed over 
the media files will turn green. 
 

 
Under its default settings, Filmora doesn’t automatically render all files you add to the timeline, so all 
video clips or visual effects you placed on the timeline after the rendering process is completed have to be 
rendered separately. The red line is going to be displayed over all unrendered media files on the timeline. 
 

 
Besides clicking on the Render Preview button, you can also hit Enter button on your keyboard to start a 
new rendering session. Rendering all media files added to timeline will make the workflow smoother and 
faster. 

Adjusting the Render Preview Settings 

You can set different render preview settings for each new project separately. Simply click on the 
Preferences option in the File menu and once the Preferences window pops up on the screen head over to 
the Performance menu. 
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Under the Preview Render menu, you can enable the Background render option which will perform the 
rendering automatically after you add a new media file to the timeline. You can set up how long it takes for 
the automatic background rendering start by setting the amount of time. However, enabling Background 
Render can slow down the Filmora video editor if your computer doesn’t have a lot of processing power. 

 
So, if you are editing a video on a computer with limited processing capabilities, you should leave the 
background render box unchecked. Filmora lets you set the destination folder for all preview renders you 
generate while working on a certain project. 

 
Click on the Browse next to the Preview Render file folder and proceed to select the destination on your 
hard drive where all preview renders are going to be kept. 
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In case you don’t want to keep the files you render after you close Filmora, you should enable 
the Automatically delete render files option when closing a project option. However, deleting render 

files is only advisable if you no longer need them, since going through the rendering process repeatedly 
can take a lot of time. 

 
Instead, you can just click on the Clean button after you completed a project and delete all preview 
render files from the destination folder. 
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